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COPYRIGHTS AND TRADEMARK NOTICES
Copyright © 2011 Telestream, Inc. All rights reserved. No part of this publication may be reproduced, transmitted,
transcribed, altered, or translated into any languages without written permission of Telestream. Information and
specifications in this document are subject to change without notice and do not represent a commitment on the part of
Telestream.
Telestream, Vantage, Flip4Mac, FlipFactory, Episode, ScreenFlow, Wirecast, GraphicsFactory, MetaFlip,
MotionResolve, and Split-and-Stitch are registered trademarks and Pipeline, Launch, and Videocue are trademarks of
Telestream, Inc.
QuickTime, Mac OS X, and Safari are trademarks of Apple, Inc.
Microsoft, Windows Media Technologies and Silverlight are trademarks of Microsoft Corporation.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Other brands, product names, and company names are trademarks of their respective holders, and are
used for identification purposes only.

AudioRestore, iZotope®; ©2011 iZotope, Inc. All Rights Reserved.
Sparkle, copyright (c) 2006 Andy Matuschak
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
RSS reader class, copyright (c) 2002, Brent Simmons. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

•

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

•

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

•

Neither the name of ranchero.com or Brent Simmons nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This project uses software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org). This toolkit is licensed as follows:
Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact: openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
ShortcutRecorder, copyright 2006-2007 Contributors. All rights reserved.
License: BSD
Jesper, waffle software, <wootest+shortcutrecorder@gmail.com>
David Dauer, <david@daviddauer.de>
Jamie Kirkpatrick, Kirk Consulting Ltd, <jkp@kirkconsulting.co.uk>
CTGradient, v 1.5, copyright (c) 2006 Cotingent.
Created by Chad Weider on 12/3/05.
Some rights reserved: <http://creativecommons.org/licenses/by/2.5/>

LIMITED WARRANTY AND DISCLAIMERS
Telestream, Inc. (the Company) warrants to the original registered end user that the product will perform as
stated below for a period of one (1) year from the date of shipment from factory:
Hardware and Media. The Product hardware components, if any, including equipment supplied but not
manufactured by the Company but NOT including any third party equipment that has been substituted by
the Distributor for such equipment (the “Hardware”), is free from defects in materials and workmanship
under normal operating conditions and use.
Software. If software is supplied as part of the product, the software will operate in substantial
conformance with specifications set forth in its product user's guide. The Company does not warrant that
the software will operate uninterrupted or error-free, will meet your requirements, or that software errors
will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:
Hardware and Media. The Company will either repair or replace (at its option) any defective Hardware
component or part, or Software Media, with new or like new Hardware components or Software Media.
Components may not be necessarily the same, but will be of equivalent operation and quality.
Software. If software is supplied as part of the product and it fails to substantially confirm to its
specifications as stated in the product user's guide, the Company shall, at its own expense, use its best
efforts to correct (with due allowance made for the nature and complexity of the problem) such defect, error
or nonconformity.
Software Updates. If software is supplied as part of the product, the Company will supply the registered
purchaser/licensee with maintenance releases of the Company’s proprietary Software Version Release in
manufacture at the time of license for a period of one year from the date of license or until such time as the
Company issues a new Version Release of the Software, whichever first occurs. To clarify the difference
between a Software Version Release and a maintenance release, a maintenance release generally
corrects minor operational deficiencies (previously non-implemented features and software errors)
contained in the Software, whereas a Software Version Release adds new features and functionality. The
Company shall have no obligation to supply you with any new Software Version Release of Telestream
software or third party software during the warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, or
any part thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of service
or modification by a party other than the Company, or (ii) Software is modified without the written consent
of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or
advice given by the Company, its distributors, dealers or agents, shall increase the scope of this Limited
Warranty or create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the country in which the
Product is purchased/licensed.
Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF
TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED
WARRANTY. Your sole and exclusive remedy for any and all breaches of any Limited Warranty by the
Company shall be the recovery of reasonable damages which, in the aggregate, shall not exceed the total
amount of the combined license fee and purchase price paid by you for the Product.

Damages
TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT
OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR
IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF
THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.
Further information regarding this limited warranty may be obtained by writing:
Telestream, Inc.
848 Gold Flat Road
Nevada City, CA 95959
You can call Telestream, Inc. via telephone at (530) 470-1300.
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CHAPTER 1
About ScreenFlow

This guide is designed to help you understand how to use each feature of
ScreenFlow, and also to provide hints, tricks, and other information to
help you make the best presentations possible.

Record. Edit.
Share.

Telestream ScreenFlow is powerful, easy-to-use screencasting software
for Mac users. With ScreenFlow, you can record the contents of your
entire monitor while also capturing your video camera, microphone, and
your computer audio.
After capturing your video and audio, you can use ScreenFlow’s video
editing tools to edit and publish your presentation. You can publish your
presentation as a QuickTime or Windows Media movie as well as publish
directly to YouTube or Vimeo.

Using ScreenFlow
in Trial Mode
Topics

Until you unlock ScreenFlow by purchasing a license and activating it,
ScreenFlow operates in trial mode. In trial mode, all of ScreenFlow’s
features are available, but your presentations are water-marked. To
unlock ScreenFlow, go to Unlocking ScreenFlow.
What’s New in ScreenFlow 3.0 (2)
Unlocking ScreenFlow (4)

2

What’s New in ScreenFlow 3.0

WHAT’S NEW IN SCREENFLOW 3.0
ScreenFlow has added many new features to improve upon the
capabilities and user experience of the program. New features include:

• New Document
— Open an empty ScreenFlow document without starting a
recording

• Full-screen preview mode
• Freehand Callouts
— Draw directly onto your screen recordings to call out specific
regions of the screen with a paint brush tool
— Blur the content you are calling out
— Add shadow options to your callouts
— Build callout in and out
— Callouts can have a default style set (through the Action Gear
menu)

• Video Annotations
— Draw circles, squares, lines and arrows over your video
content
— Adjust the size, color, position, shadow and thickness
— Save default annotation styles

• Improved Timeline features
— Added "Timeline" preferences including default timeline height,
default duration of still image, and use of SMPTE timecode
— Reorder tracks
— Resize height of tracks
— Easily delete tracks
— Insert space or gaps in the timeline
— Select gaps between clips and remove them
— Set duration of transitions durations through the inspector
— Preview and customize transitions
— Group and ungroup clips
— Jump to marker in timeline from the Markers window
— Added ability to select all clips on a track by double-clicking
track sidebar or clip context menu

• Media Library improvements
— Preview video and audio in your media library
— Resize library items in the media library

• Audio improvements
— View audio waveforms and clipped audio peaks directly in the
timeline and see effects & volume changes directly.
— Smooth volume levels (combines limiting, compression and
more) throughout your clips
— Convert your text to synthesized speech
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• Export improvements
—
—
—
—
—
—
—
—
—

Create and save your own export presets
See estimated time remaining in export
Export to iPad with iPad preset
Export high performance lossless audio only with preset
Save your files to Recent Places from the Export Window
Publish directly to Vimeo
Choose letterbox option in the YouTube publishing window
720p and 1080p support for YouTube publishing
Full integration with the Elgato Turbo H.264 device

• Video canvas improvements
— Use cursor keys to move video clips around the canvas
— Set exact position for an object by entering the coordinates in
the inspector
— Change background color of your canvas
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Unlocking ScreenFlow

UNLOCKING SCREENFLOW
Note: This does not apply to users who purchased from the Mac App
Store. The App Store has its own installation and licensing procedure.
To unlock ScreenFlow from trial mode, you must purchase and install a
ScreenFlow license.

Purchasing
through the
application

The easiest way to activate ScreenFlow is to purchase through the
application.
1. Launch ScreenFlow
2. Select Purchase > Purchase ScreenFlow Online to display the

License panel of the ScreenFlow Preferences window.
Figure 1. Preferences Licenses pane (unlicensed)

Note: If ScreenFlow doesn’t display a Purchase menu, then you have
already registered ScreenFlow.
3. Click the Lock icon at the bottom of the panel, and enter your

password to allow ScreenFlow to make changes to your license.
Note: Your user must be an administrator. If your username is not an
administrative account, you’ll need to create one in order to continue.
4. Click the Purchase License button. This sends you to the Telestream

online store where you may purchase a license.
5. Upon completion of your purchase, the ScreenFlow license installs

automatically.

Activating Your
License

If you have already purchased a license through the Telestream online
store, Telestream sends you an email receipt containing your license key.
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Note: If your Macintosh is not connected to the Internet, follow the
instructions in the Manual Activation Guide (http://www.telestream.net/
pdfs/user-guides/Manual_Activation_Guide.pdf) to activate your license
and unlock ScreenFlow.
The easiest way to register and activate ScreenFlow is to click on the link
provided in your email receipt. If this link doesn’t work, register
ScreenFlow as follows:
1. Launch ScreenFlow.
2. Select Purchase > Unlock ScreenFlow to display the License panel in

the ScreenFlow Preferences window.
Note: If ScreenFlow doesn’t display a Purchase menu, then you have
already registered ScreenFlow.
3. Click the Lock icon at the bottom of the panel, and enter your

password to allow ScreenFlow to make changes to your license.
Note: Your user must be an administrator. If your username is not an
administrative account, you’ll need to create one in order to continue.
4. Click the Enter Serial Number button and enter the license key into the

license key field:
Figure 2. Enter your serial number to unlock ScreenFlow

5. Click Activate to activate your serial number and unlock ScreenFlow.

Note: If the Activate button is dimmed, it means that the license is
invalid. Double-check your license from the e-mail. Make sure that all
letters are capitalized, dashes are included, and all 0’s are zeros, not the
letter O. It may also help to copy and paste your serial number from your
e-mail, but be careful not to copy any additional text such as a “space.” If
you are still having problems, please contact technical support.
6. Now your serial number is activated and ScreenFlow is unlocked.

Close the Preferences window to continue.
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CHAPTER 2
Getting Started

These tours are designed to introduce you to the features and capabilities
of ScreenFlow.
We encourage you to take these tours before beginning a project. They
help you to gain a basic understanding of how ScreenFlow works and
help to familiarize yourself with the program.
Every ScreenFlow project is a three step process: first you record your
presentation, then you edit your screencast, and finally you export your
screencast to a usable video format.
For video tutorials, please visit our ScreenFlow demos page.

Tours

Tour 1 – Recording With ScreenFlow (8)
Tour 2– Editing Your Screencast (10)
Tour 3– Exporting Your Screencast (16)

8

Tour 1 – Recording With ScreenFlow

TOUR 1 – RECORDING WITH SCREENFLOW
When launching the program, ScreenFlow displays a Configure
Recording window.
Figure 3. ScreenFlow recording window

Before you create your first screencast, take a moment to consider ways
of approaching the process.
This first tour focuses on creating a high quality recording for editing and
publishing. When creating a screencast, it is important to prepare your
recording properly while considering how you intend to use this
screencast later in your workflow.
We recommend that you create at least one sample recording to
familiarize yourself with the program before creating your intended
screencast.

Configure Your
Recording

Use the Configure Recording window to enable your recording sources.
This automatically opens when you launch the application, but it can also
be accessed from the ScreenFlow Helper > Configure Recording… (22)
or File > New Recording.
Record Desktop from. This option records your computer display. This
source records by default and cannot be deselected. If you have multiple
displays connected, you can choose between them. ScreenFlow cannot
record multiple displays simultaneously.
Record Video from. This option records video from any camera
connected to your computer. Use the dropdown menu to choose from
multiple cameras. Upon selecting a source, a preview image displays
below.
Record Audio from. This option records from any microphone
connected to your computer. Use the dropdown menu to choose from
multiple microphones. Upon selecting the source, the volume level is
displayed below.
Record Computer Audio. Choose this option to record all sounds
played through your computer. The ScreenFlow audio driver must be
installed to use this setting. If the driver is not installed, you are prompted
to install it.
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Beginning Your
Recording

When you are ready, click the Record button. ScreenFlow enters a
countdown mode before recording. The length of this countdown is set in
Countdown for [x] secs before recording (68). Default is five seconds.
Create a short presentation then stop your recording: press ShiftCommand-2 or select Stop Record from the ScreenFlow Helper (22)
menu in the upper-right corner of your display.
After you have stopped your recording, ScreenFlow opens your recording
in the ScreenFlow editing window with all of your recorded sources
placed in the timeline.
Display video and computer audio are combined into one clip while
camera video and microphone audio are combined in another clip. This is
done to maintain video/audio sync. Video and audio can be separated by
selecting the clip and choosing Detach Audio from the Edit dropdown
menu.

74-0291-00
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Tour 2– Editing Your Screencast

TOUR 2– EDITING YOUR SCREENCAST
The purpose of this tour is to familiarize you with the basic editing
features of ScreenFlow. This tour describes some of the most common
and basic editing techniques.
For a more comprehensive description of editing features, see Editing
Presentations (27).
When you finish your recording, ScreenFlow creates a new document
and recorded material is placed at the beginning of the timeline. All media
in the timeline is referenced to your project’s stored media. Changes
made in the timeline or on the canvas do not alter your original recording.

The Editing
Window

The space used for editing is the editing window, which consists of three
main panels.
Figure 4. Editing window
Canvas

Canvas controls

Properties

Playback controls

Timeline

Canvas. The large, central area of the editing window is called the
canvas. This offers a preview of all content displayed in your screencast.
The gray space around the preview is for content that will not be present
in your exported video. This is used to display off-screen content present
in scaling or pan effects. The content displayed on the canvas reflects the
position of the scrubber on the timeline.
Canvas size and background color can be set using the Canvas Controls
(30).
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Timeline. The wide area at the bottom of the screen is the timeline. This
is a visual representation of the temporal length of your screencast. The
scale at the top of the timeline represents measurements of time.
The red vertical line on the timeline is called the scrubber. This represents
the current temporal position of the preview on the canvas.
The timeline is divided into tracks to manage different clips overlapping at
the same time. If the clip is visual (i.e. video, image, or text), the upper
most track is displayed over the lower tracks.
Between the canvas and the timeline are playback controls to play your
screencast as well as jump to the beginning or end of your screencast.
Properties. On the upper-right side of the editing window are the
Properties. These are the main editing controls of ScreenFlow and
include numerous changes to image and audio display. It also includes
the media library which stores all recorded and imported media in an
unaltered state.
For more information, see Editing Window (28).

Cropping

ScreenFlow provides two different types of cropping.
Figure 5. Canvas controls

Canvas cropping. Canvas cropping is used to change the resolution or
aspect ratio of the workspace you have to edit in. This can be useful if you
want to constrain your screencast to only a portion of the total recording
(i.e. a foreground window).
Canvas cropping is accessible through the canvas control button. This is
set by numerically entering the width and height values or dragging the
edge of the canvas with your mouse cursor.
The canvas cannot be set to a value larger than the original recording.
Remember, the canvas size represents your total usable display space.

74-0291-00
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Image cropping. Image cropping is useful for removing content from the
edge of a visual element. Unlike canvas cropping, image cropping does
not limit your workspace but simply alters the content of video or image
material.
To crop an image, select the video or still image presented on your
canvas. This highlights the image and place handles on the sides. Hold
the CTRL key and drag the edge of the image to crop it.

Actions

Actions are property changes used to transition the media from one state
to another. Actions are placed by highlighting the clip in question, opening
the property that you wish to alter, then clicking the Add Action button at
the bottom of the properties pane. The action is placed in relation to the
position of the scrubber, but can be moved on the clip. The duration of the
action is changed by dragging the edge of the action to lengthen or
shorten the action.
Figure 6. Video Properties action

Place the scrubber before or after the action to make changes to the
property relative to the action. When the scrubber is placed before the
action, this sets the properties of the clip before the action. When the
scrubber is placed after the action, this sets the properties of the clip after
the action.
For more information, see Actions (37).
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Video Properties

Video properties can be used to make changes to any recorded or
imported video or image file. This includes the display and camera
recordings.
This tour focuses on the most common features. For more details, see
Video Properties (38).
Figure 7. Video Properties

Scale. Use this option to change the size of a video or image relative to
the size of the canvas. This can be used for highlighting a particular
portion of the screen or with a video action to create a zoom effect.
Use the slider or enter a percentage value to change the image scale.
Position. Position represents the location of your video or image on the
canvas. The position is based on the exact placement of the upper left
corner of your image. If the image is in the upper left corner of the canvas,
the location is zero on both the X and Y axis. Values in the position field
are represented in pixels.
You can reposition the image by dragging the image on the canvas,
nudging the image with the arrow keys, or entering a numerical value in
the position fields.
Opacity. This is the degree to which the image is translucent. The greater
the value, the more opaque the image. If the value is set to zero, the
image is invisible.
This is used with a video action to fade an image in or out. It is particularly
useful if you would like to periodically display your camera recording.
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Screen Recording
Properties

Screen recording properties are effects specific to demonstrations using
the mouse and keyboard. They can only be applied to screen recordings.
This tour focuses on the most common features. For more details, see
Screen Recording Properties (42).
Figure 8. Screen Recording Properties

Pointer Zoom. Often it can be difficult to see the mouse in a screencast,
particularly if the video has been significantly resized. Increasing the
pointer zoom value makes the mouse cursor larger and easier for the
viewer to follow.
Click Effect. This feature can be used to make a visual effect when you
click your mouse. Select Radar to project a red circle with each click or
Invert to change the cursor from black to white with each click.
Sound on click. Select this option to generate a click sound when the
mouse button is pressed.
Show keys pressed. Select this option to display the text as you were
typing it while recording.
Show modifier keys pressed. Select this option to display modifiers
used in hotkey commands, F1 through F12, and the arrow keys.

Callout Properties

Callout Properties are used to highlight a specific portion of the screen.
They can only be applied to screen recordings. Unlike the other
properties, Callout Properties must be used with an action.
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This tour focuses on the most common features. For more details, see
Callout Properties (44).
Figure 9. Callout Properties

Highlight. Callouts are capable of highlighting an area in three different
ways. Mouse Cursor highlights a circular space around the mouse cursor.
Foreground Window highlights any window which is currently active.
Freehand allows you to draw the area you wish to highlight.
Opacity. The opacity slider controls the opacity of the space outside the
callout. A low value makes the surrounding area opaque while a high
value makes the surrounding area invisible.
Zoom Up. This option magnifies the area inside the callout to make it
more prominent.
Border. This option increases the range of the callout area to draw
attention to a larger space. This feature is not available with freehand
callouts.

Media Library

The media library stores all recorded and imported media in an unaltered
state. This material may be dragged to your timeline or canvas for editing.
You may drag this content into your project multiple times to copy the
same material.
For more information, see Media Library (49).
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15

16

Tour 3– Exporting Your Screencast

TOUR 3– EXPORTING YOUR SCREENCAST
The purpose of this tour is to familiarize yourself with the basic exporting
features of ScreenFlow. Until the screencast is exported from
ScreenFlow, it is saved in a proprietary.screenflow format which cannot
be used by any other program.
Finding the right export settings for your screencast depends on the
complexity of your screencast and the intended use of the screencast
after it has been produced.
This section offers basic information about export options. For a more
comprehensive description, see Exporting Presentations (51).
Press Command-E or select File > Export to export your presentation:
Figure 10. Export settings window

Save As

Choose a name for your exported video. Default is “ScreenFlow.mov.”

Where

Choose a location to export your video.

Preset

ScreenFlow has several export presets for your convenience. This tour
focuses on the most commonly used presets.
For more information, see Preset (52).
Web - High. This is the default export option which encodes using the
H.264 codec. It was chosen as the default codec based on both image
quality and file size.
Web - Low. This is an export option similar to Web - High, but formatted
for a low bandwidth. It plays more smoothly on slow internet connections
but the image quality is not as good as Web - High.
Lossless. This is an uncompressed export format ideal for additional
editing. This format has the highest quality image but also the largest file
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size. When exported at 100%, the image quality is identical to the original
recording.
iPad / iPhone / Apple TV / iPod. These export options are formatted
based on the recommended video specifications for these devices. They
cannot be altered.
Windows Media. This option exports a video in the WMV format. This is
a popular format for Windows users. This option uses a QuickTime plugin
called Flip4Mac which must be licensed separately.

Dimensions

These options are used to set the dimensions of your video export. You
should not set a size larger that your canvas size. This does not improve
image quality.
Scale by. Use this option to scale your project by a percentage value.
This is an easy way to shrink your screencast while maintaining the
aspect ratio.
Scale to custom size. Use this option to set the exact width and height
of your exported video. Click the Letterbox Content box to add
letterboxing to your export.

Publish to
YouTube/Vimeo/
Flash

74-0291-00

In addition to encoding a video file, ScreenFlow can also publish
screencasts directly to YouTube, Vimeo, and Flash. These options are
accessible from the File menu.
For more information, see Publish to YouTube (60), Publish to Vimeo
(62), and Publish to Flash (65).
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CHAPTER 3
Recording
Presentations
The first step in creating a screencast is to record your content. This
section guides you through the procedure of recording and the options
available.
Note: ScreenFlow automatically stops recording when you have less
than 100 megabytes free on your system disk volume.

Topics

Configure Recording (20)
ScreenFlow Helper (22)
Adding A Recording (23)
Preference Options (24)
Recording Tips (25)
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Configure Recording

CONFIGURE RECORDING
The first step in creating any screencast is to record your sources.

Configure Your
Recording

Upon launching ScreenFlow, ScreenFlow automatically displays the
Configure Recording window to help you begin your screencast. It can
also be accessed from the ScreenFlow Helper > Configure Recording…
(22) or File > New Recording.
To add a new recording see, Adding A Recording (23).
Figure 11. ScreenFlow recording window

Record Desktop from. This option records your computer display. This
source records by default and cannot be deselected. If you have multiple
displays connected, you can choose between them. ScreenFlow cannot
record multiple displays simultaneously.
Record Video from. This option records video from any camera
connected to your computer. Use the dropdown menu to choose from
multiple cameras. Upon selecting a source, a preview image is displayed
below.
Record Audio from. This option records from any microphone
connected to your computer. Use the dropdown menu to choose from
multiple microphones. Upon selecting the source, the volume level is
displayed below.
Record Computer Audio. Choose this option to record all sounds
played through your computer. The ScreenFlow audio driver must be
installed to use this setting. If the driver is not installed, you are prompted
to install it.
Record Button. Click the Record button to display the countdown
window and begin recording.
When you have finished recording, video and audio sources are
combined to maintain video/audio sync. Desktop video is combined with
computer audio while camera video is combined with microphone audio.
These clips may be separated using the Detach Audio (85) command in
the Edit Menu (83).
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Countdown

When you start recording, ScreenFlow displays a countdown panel to
allow you to prepare yourself for the recording:
Figure 12. ScreenFlow displays the countdown window

By default, the countdown is set to 5 seconds. This option can be
changed or disabled in ScreenFlow > Preferences > General.
ScreenFlow accepts a delay time between one and ten seconds only.
To skip the countdown, simply click on the countdown window and
ScreenFlow records immediately.
To monitor the status of your recording, use the ScreenFlow Helper menu
located on the right side of the menu bar.

74-0291-00
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ScreenFlow Helper

SCREENFLOW HELPER
ScreenFlow utilizes a background application called ScreenFlow Helper
to manage various aspects of your recording. This is located on the right
side of the menu bar at the top of the display.
The ScreenFlow Helper menu contains the following items:

Record/Stop
Record (shiftCommand-2)

Begins recording using the most recently selected sources (display,
camera, microphone, and/or computer audio). The menu icon changes
from

to

to show that ScreenFlow is recording.
Select Stop Record or press shift-Command-2 to stop the recording. The
hotkey for this command may be customized in Recording Hotkey (68).

Pause/Resume

Pauses the recording. Resume recording by selecting Resume. This
command may be set using a Pause Hotkey (68).

Configure
Recording…

Displays the Configure Recording (20) window for setting recording
parameters.

Hide Desktop
Icons/Show
Desktop Icons

You can hide all icons on your Desktop if you prefer to have a less
cluttered background to your screen recording. You can show them again
when you need to interact with your Desktop.

Quit ScreenFlow

Quits the ScreenFlow and ScreenFlow Helper applications.
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ADDING A RECORDING
When you have finished your recording, the clips that you have recorded
are automatically opened in a new document. If you already have a
document open, you are given the option of creating a new document or
adding your recording to an existing document.
Figure 13. Use the Recording Complete dialog to save your clip

If you have accidentally created a new document when you intended to
add the recording to an existing document, simply navigate to the Media
Library (49) in the new document and drag your recording into the
previous document’s canvas, timeline, or media library. This duplicates
the recording in the other document.

Add Additional
Recording (ShiftCommand-R)

To add a recording to your document, you may simply create a new
recording, in which case you receive notification (as illustrated above) or
you may choose Add Additional Recording. This may be selected from
the File menu or the Media Library (49).
In the Add Additional Recording window, you are presented with options
similar to the Configure Recording (20) window.
Figure 14. Add Additional Recording window

The only differences between this window and the Configure Recording
window are the option to deselect desktop recording and close
ScreenFlow before recording.
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PREFERENCE OPTIONS
There are several preference options available which relate to
ScreenFlow recording.
For a more complete description, see Preferences (67).

General

Show ScreenFlow options in Menu Bar. You can enable or disable
ScreenFlow Helper in the Preferences settings dialog. By default, this
option is on.
Countdown for [x] secs before recording. This option sets the delay
between when you press record and when ScreenFlow begins recording.
This is used to prepare yourself for your demonstration.
By default, the countdown is set to 5 seconds. ScreenFlow only accepts a
delay time between one and ten seconds.
Launch ScreenFlow Helper at user login. Select this option to have
ScreenFlow Helper available when you log on to your user account. By
default, this option is off.
Recording Hotkey. This is a shortcut command used for both starting
and stopping your recording.
By default, this option is set to Shift-Command-2. When setting a custom
hotkey, it is important to choose a command which is not in use by other
programs.
Pause Hotkey. This is a shortcut command used for both pausing and
resuming your recording.
By default, this option is not set. When setting a custom hotkey, it is
important to choose a command which is not in use by other programs.

Advanced

Screen Recording Compression. This option is used to choose
between a compressed and uncompressed recording. By default, it is set
to Adaptive which is a compressed method. This is used to minimize file
size, but the difference in quality is not be noticeable to most users.
Computer Audio. This button is used to install or uninstall the
ScreenFlow audio driver. The driver must be installed to record computer
audio.
Capture Scratch Disk. This option is used to set the temporary storage
location while you recording is being generated. By default, this is set to a
private system location. Setting a custom Capture Scratch Disk allows
you to more easily locate your recording in the event that your recording
is interrupted before completion.
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RECORDING TIPS
Before you begin your recording, it can be useful to consider what you
intend to do with your screencast, how you would like to organize your
media, and how best to present the content on screen.

Set Your Display
Resolution

One important thing to consider before beginning your recording is the
resolution of your display and the intended resolution of your screencast.
Since you usually do not intend to export your screencast at the same
resolution that you recorded at, it is important to consider that your final
video will be at a lower resolution than it is on your screen. This is
especially important when you have text which must be legible. Digital
video was not designed to capture text, so it can often be difficult to
capture legibly.
We recommend that you check your display resolution before recording.
This can be done in System Preferences > Displays. Lower your
resolution as much as possible without impairing your ability to
demonstrate your screencast. Do not lower the resolution below your
intended export resolution or you will lose quality.

Using Text

Digital video was designed for capturing real world images, so it is often
difficult to capture the thin lines of text legibly. Here are a few tips if you
are using text in your video:

• Use larger point sizes (e.g., at least 25 points or more). Larger characters always render better than small ones.

• Do not use serif fonts (e.g,. Times Roman). Always use sans-serif
fonts (e.g., Arial or Helvetica).

• Use boldface fonts, since they render better, especially at smaller
sizes.

• Do not use odd values for the output movie's frame height or width.
Always use even numbers. Also, input sources having odd height or
width values can result in illegible titles.

• Always generate non-interlaced video. Interlaced video is much more
prone to poor quality text rendering because it may introduce flickering.

Considerations for
Narrative
Demonstrations

Record Everything at Once. Using this method, you record each
recording source in a single session – simultaneously recording the
display, camera video, microphone audio, and computer audio. When you
are done recording, you can use the editing tools to finalize your
screencast.
For example, you might start a presentation recording your display, then
cut to a Picture-in-Picture of your camera recording, as you demonstrate
the application. Later, you fade out your video, leaving only the audio to
narrate the remaining moments of the screencast.
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This method is considered a single-pass production. It works well when
your subject matter is simple, straightforward, or short. For longer or more
complex project, you may find the second approach more comfortable.
First Record Your Monitor, Then Add Narration. Using this method,
you first record the display (with or without computer audio),
demonstrating your application or subject matter without any video or
voice-over.
When you have finished your demonstration, you can record your camera
and microphone sources while playing the video preview of your
demonstration in ScreenFlow. This can be done in a single long recording
or several short recordings.
You can then edit your recordings to align your narration with your
demonstration or fade your camera recording in and out when
appropriate.
This workflow is effective when the screencast involves a series of
complex mouse or keyboard operations, or you have several
comprehensive steps or tasks to achieve, each of which take some effort
to produce.
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Editing Presentations

When you have completed your recording, your recorded media is placed
in a ScreenFlow document for editing. Here you can edit your screencast
and add effects for clarity, emphasis, and presentation.

Topics

Editing Window (28)
Canvas (30)
Timeline (32)
Transitions (36)
Actions (37)
Video Properties (38)
Audio Properties (40)
Screen Recording Properties (42)
Callout Properties (44)
Annotations Properties (46)
Text Properties (47)
Media Library (49)
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Editing Window

EDITING WINDOW
When you finish your recording, ScreenFlow creates a new document
and recorded material is placed at the beginning of the timeline. All media
in the timeline is referenced to your project’s media library. Changes
made in the timeline or on the canvas do not alter your original recording.
The space used for editing your project is called the editing window. This
consists of three main areas.
Figure 15. Editing window
Canvas

Canvas controls

Properties

Playback controls

Timeline

Canvas. The large, central area of the editing window is called the
canvas. This offers a preview of all content displayed in your screencast.
The gray space around the preview is for content that will not be present
in your exported video. This is used to display off-screen content present
in scaling or pan effects.
The content displayed on the canvas reflects the position of the scrubber
on the timeline.
Canvas size and background color can be set using the Canvas Controls
(30) button.
Timeline. The wide area at the bottom of the screen is the timeline. This
is a visual representation of the temporal length of your screencast. The
scale at the top of the timeline represents measurements of time.
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The red vertical line on the timeline is called the scrubber. This represents
the current temporal position of the preview on the canvas.
The timeline is divided into tracks to manage different clips overlapping at
the same time. If the clip is visual (i.e. video, image, or text), the upper
most track is displayed over the lower tracks.
Properties. On the upper-right side of the editing window are the
Properties. These are the main editing controls of ScreenFlow and
include numerous changes to image and audio display. It also includes
the media library which stores all recorded and imported media in an
unaltered state.
Playback Controls. Between the canvas and the timeline are playback
controls to play your screencast as well as jump to the beginning or end of
your screencast.
To the right of the playback controls are the audio meters. The top meter
represents the left speaker channel while the bottom meter represents the
right speaker channel.
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Canvas

CANVAS
The canvas is the preview section of the editing window which allows you
to organize the visual elements of your project in a two dimensional
space.
Video editing may take place on the canvas itself or by accessing the
canvas controls using the canvas button.
Figure 16. Canvas controls

Canvas Controls

Canvas cropping. Canvas cropping is accessible through the canvas
control button. This is set by numerically entering the width and height
values or dragging the edge of the canvas with your mouse cursor.
The canvas size cannot be set to a value larger than the original
recording.
Remember, the canvas size represents your total usable display space.
Background color. Select this option to choose the background color of
the canvas. The default setting is black.
Snap to Front Window. Select this option if you intend to highlight a
foreground window in your recording and wish to crop the area outside of
that window. This helps you to crop the canvas around the foreground
window.
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Image
manipulation on
the canvas

The canvas is used for quickly and easily altering any image in the
project.
Click on an image in the canvas to select it. This highlights the image both
in the canvas and the timeline The image on the canvas is placed in
brackets.
Image Scaling. Select a bracket and drag your mouse to scale and
distort the image. Hold the Shift key while scaling to preserve the aspect
ratio of the image.
Image cropping. Hold the CTRL key and drag the edge of the image
inward to crop it.
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Timeline

TIMELINE
The timeline is a visual representation of the length of time in your
ScreenFlow project. The timeline displays all clips and actions in your
timeline and represents the start and end time for these elements.
Figure 17. Timeline

Scale

On the top of the timeline is the scale. This offers a precise indication of
the amount of time represented in the timeline. When you begin your
project, the scale automatically adapts to the length of your recorded
media.
You can change the scale magnification using the slider in the lower left
corner of the window. At maximum magnification, each line on the scale
represents a single frame of video.
Use the left and right arrow keys to move the scrubber by a single frame.
Figure 18. Timeline magnification slider

Tracks

Media in the timeline is placed sequentially or on overlapping tracks.
Visual media placed on a track should be placed in relation to media
above or below it.
For example, a text box placed on a track above a screen recording
overlays the text on top of the screen recording. If the text box is placed
on the track below the screen recording, it is behind the recording and not
visible.
Track Controls. The height of the track is adjustable using the arrow
buttons on the left side of the track. Click the down arrow to decrease the
track height or click the up arrow to increase the track height. This can
make it easier to manage content in your timeline.Select the track position
handle to drag your track up or down in relation to the other tracks.
Figure 19. Track controls

Track size
Track position
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Splitting &
Trimming

ScreenFlow uses a few simple commands for quick editing of content in
your timeline.
Splitting. If you would like to split your clip into multiple smaller clips,
position the scrubber over the moment where you would like this split to
occur, then hit the T key. This splits the clip at the scrubber into two clips.
Trimming. If you would like to trim content off the front of the clip, position
the scrubber over the moment where you would like the clip to begin, then
hit the W key. This trims all content from the front of the clip to the
scrubber.
If you would like to trim content off the end of the clip, position the
scrubber over the moment where you would like the clip to end, then hit
the E key. This trims all content from the end of the clip to the scrubber.
You can also grab the edge of the clip and pull it inward to trim the
content. If the edge of the clip has already been trimmed, you can pull the
edge out from the clip to restore trimmed content.

Create or close a
gap in the timeline

To quickly create a gap in the timeline to place new content, position the
scrubber where you wish the gap to occur, then grab the handle at the
bottom of the scrubber and move it to the right. If the scrubber intersects a
clip, it splits the clip in two.
To quickly close a gap, drag the handle to the left. This does not join clips
which have been split. If clips overlap while closing the gap, this forms a
transition.
You can also right-click (or CTRL-click) in the empty space and choose
Close Gap.

In and Out Points

You can select a range across tracks to take action specific to this part of
the timeline. This range is set by applying an in point and an out point.
Figure 20. Mark In and out points on your timeline

Position the scrubber and press the I-key to set an in point or the O-key to
set an out point. Shift-click on the timeline scale to set in and out points
relative to the position of the scrubber.
When you create an in point without an out point, ScreenFlow
automatically sets the out point to the end of the last clip in the timeline.
When you create an out point without an in point, ScreenFlow
automatically sets the in point to the beginning of the timeline
In and out points can be used to delete entire sections of your timeline,
using Ripple Delete (Command-Backspace) (87). You can also export the
in/out range using Export (Command-E) (82) if you do not want to export
your entire project.
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Timeline

Changing Speed

Hold the OPT key and move your cursor to the edge of the clip. The
cursor then displays a clock icon indicating that you are about to change
the speed variable on the clip. Move the edge of the clip inward to speed
the clip and outward to slow the clip. This clip is marked with a turtle or
rabbit icon to indicate whether the clip speed was decreased or
increased.
Figure 21. Speed change icons

This option is useful for quickly moving past a process that does not need
to be shown in detail or slowing a quick processes which should be
viewed in greater detail.

Grouping

Select multiple clips and go to Edit > Group to link them to one another.
This allows you to move the clips together as a single element. This can
be useful if you have a sequence of clips arranged that you do not wish to
alter. Go to Edit > Ungroup to remove the grouping.

Locking

Select a clip and go to Edit > Lock Clip to lock the clip on the timeline.
This clip is dimmed and cannot be selected or moved. This can be useful
if you have a clip or clips placed exactly where you want and do not wish
to alter it. Go to Edit > Unlock Clip to remove the lock.
Figure 22. Locked and unlocked clips

Freeze Frame

If you want to pause on a single frame of video while editing, select the
clip and move the scrubber to the frame that you would like to pause. Go
to Edit > Add Freeze Frame to create a still image of the current frame of
video. This splits the video and adds a two second freeze frame within the
split. The duration of the freeze frame can be set by expanding or
contracting the clip.
Figure 23. Freeze frame
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Markers

Markers are placed on your timeline to identify a particular time mark on
your screencast. Move the scrubber to the desired location then go to Edit
> Markers > Add to generate a marker. This creates a dialog allowing you
to name the marker. Go to Window > Markers to view a list of markers
and quickly move to their location. You may export marker locations as
chapters in supported formats.
For more information, see Add Chapter Track from Markers (54).

Clip Contact Menu

Right-click (or Control-click) on a clip in the timeline to show the clip
contact menu.
Figure 24. Clip contact menu

This menu represents numerous menu options detailed in the Edit Menu
(83). Detailed below are options only available through this menu.
Show Clip Inspector. Select to open the Clip Inspector window.
Figure 25. Clip Inspector

Here you can change the duration or speed of a clip as well as lock it from
further editing.
Rename Clip. Select to rename the clip in the timeline. The new name
only effects this specific clip and does not change the name of the source
in the media library. You can also change the name by double-clicking the
name of the clip on the clip itself.
Track Selection. Use the All Clips option to select all clips on this track.
Use the All Clips after current Clip option to select all clips following the
selected clip on this track.
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TRANSITIONS
Transitions are applied to clips to create a smooth progression into, out of,
and between clips.

Adding transitions

Select a clip and go to Edit > Add Starting Transition to add a transition to
the front of the clip or Edit > Add Ending Transition to add a transition to
the end of the clip. The default duration of a transition is one second. You
can expand or contract the duration of the transition by moving the thin
line on the inside portion of the transition.

Transitions
Inspector

Double-click the transition icon to bring up the Transitions Inspector. Here
you may choose from between sixteen different transition types and set
the duration of the transition in seconds.
Figure 26. Transitions Inspector window

Select a transition effect then click the Properties button to alter properties
specific to that transition effect.

Overlapping

Transitions between clips are easily created by dragging the one clip over
another in the timeline. The section where these two clips overlap
automatically creates the transition.

Audio Transitions

Transitions are applied to audio clips in the same manner as image clips,
however, since there is no visual content in an audio clip, the transition
only effects volume. Starting and ending transitions create a fade in/fade
out effect while overlapping transitions fade from one clip to the other
simultaneously.
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ACTIONS
Actions are property changes used to progress the media from one state
to another. Actions are placed by highlighting the clip in question, opening
the property that you wish to alter, then clicking the Add Action button at
the bottom of the property pane. The action is placed in relation to the
position of the scrubber, but can be moved to any location on the clip. The
duration of the action is changed by dragging the edge of the action to
lengthen or shorten the action
Figure 27. Video Properties action

Place the scrubber before or after the action to make changes to the
property relative to the action. If the scrubber is placed before the action,
this sets the properties of the clip before the action. If the scrubber is
placed after the action, this sets the properties of the clip after the action.

74-0291-00

37

38

Video Properties

VIDEO PROPERTIES
Video properties can be used to make changes to any recorded or
imported video or image file. This includes the display and camera
recordings.
Figure 28. Video Properties

Scale

Scale is used to change the size of a video or image. This is useful for
highlighting a particular portion of the screen or with a video action to
create a zoom effect.
Use the slider or enter a percentage value to change the scale of your
image.

Position

Position represents the location of your video or image on the canvas.
The exact location is based on the position of the upper left corner of your
image. If the image is in the upper left corner of the canvas, the location is
zero on both the X and Y axis. Values in the position field are represented
in pixels.
You can reposition the image by dragging the image on the canvas,
nudging the image with the arrow keys, or entering a numerical value in
the position fields.
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X/Y/Z Rotation

The rotation options enable the user to rotate a two dimensional image in
a virtual three dimensional space. Values in the rotation field represent
degrees.
X Rotation rotates the image along a fixed horizontal axis. Y Rotation
rotates the image along a fixed vertical axis. Z Rotation spins the image
along a fixed depth axis.

Opacity

Opacity is the degree to which the image is translucent. The greater the
value, the more opaque the image. If the value is set to zero, the image is
invisible.
This may be used with a video action to fade an image in or out. It is
particularly useful if you would like to periodically display your camera
recording.

Reflection

Reflection creates a mirror image of the selected object below the object
itself. The slider represents the opacity of the reflection with 0% being
invisible and 100% being entirely opaque.

Shadow

This option is used to create a shadow effect behind a still image. If you
image uses a transparency, the shadow only reflects the non-transparent
part of your image.
Angle. The value immediately to the right of Shadow represents the
angle of the shadow relative to the image and is represented in degrees.
The default is -45 degrees.
Color. The color field allows you to select the color of the shadow. The
default option is black.
Offset. Offset determines the distance between the shadow and the
object. This value is represented in pixels. The default is 40.
Opacity. This represents the opacity of the shadow with 0% being
invisible and 100% being entirely opaque. The default is 75%.
Blur size. This represents a gradual loss in opacity as the shadow
spreads from the center. The default value is 4.

Saturation

Saturation is the intensity of a color relative to its brightness. This value is
represented as a percentage and may be set between 0 and 400. The
default is 100%.

Brightness

Brightness is the degree of luminosity present in the image. This value is
represented as a percentage and may be set between 0 and 400. The
default is 100%.

Contrast

Contrast is the relative intensity of the black and white values in an image.
A high contrast has a greater intensity of black and white values. This
value is represented as a percentage and may be set between 0 and 400.
The default is 100%.
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Audio Properties

AUDIO PROPERTIES
Audio properties are used to change audio clips in your timeline. It may be
applied on any clip which contains audio, including clips with both video
and audio content.
Figure 29. Audio Properties

Any clip which uses audio content displays with a waveform. This
waveform adjusts to reflect any volume changes.
Figure 30. Audio clip in timeline

This image shows an audio clip with an audio action set to increase
volume. Notice how the waveform changes due to the action.

Volume

Use the slider or enter a percentage value to change the audio on a clip.
This can be used with an action to gradually change the audio level as
shown in the image above.

Ducking

Audio ducking is used to automatically adjust volume levels on
overlapping audio clips. When applied to a clip, all overlapping audio is be
muted to draw attention to the audio in this clip. The amount of audio
reduction is determined by a percentage value which can be adjusted
using the slider. This is useful when using background music with
narration.
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Mute Audio

This is used to mute an audio clip.

Mix Input to Mono

This feature mixes multichannel audio into a single mono channel.

Processing:
Smooth Volume
Levels

Select this option to normalize and smooth out volume peaks while
increasing quieter elements so that the audio has a more consistent
volume.

Effect

This option applies different audio effects to the audio clip. The Amount
slider determines the degree by which this effect alters the original audio.

Filter: Remove
Background Noise

Use to reduce the audio volume of incidental background noise, which
typically results in a clearer audio track. The Amount slider determines the
sensitivity of the filter.
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Screen Recording Properties

SCREEN RECORDING PROPERTIES
Screen recording properties are effects that are specific to
demonstrations using the mouse and keyboard. They can only be applied
to screen recordings.
Figure 31. Screen Recording Properties

Pointer Zoom

Often it can be difficult to see the mouse in a screencast, particularly if the
video has been significantly resized. Increasing the pointer zoom value
makes the mouse cursor larger and easier for the viewer to follow.

Click Effect

This feature is used to make a visual effect when you click your mouse.
Select Radar to project a red circle with each click or Invert to change the
cursor from black to white with each click.

Pointer

This option allows you to change the pointer image. Click Choose Image
to replace the pointer image with any custom image.

Opacity

This represents the opacity of the pointer with 0% being invisible and
100% being entirely opaque. This may be used with an action to fade the
pointer in or out.

Sound on click

Select this option to generate a click sound when the mouse button is
pressed.
Volume. This option changes the volume level of the mouse click sound.
This field accepts values from zero to 5,000%.
Click Sound. Use this option to play a unique sound file every time the
mouse is clicked.

July 2011

Chapter 4 Editing Presentations

ScreenFlow User’s Guide

Show keys
pressed

Select this option to display the text you were typing while recording.

Show modifier
keys pressed.

Select this option to display modifiers used in hotkey commands, F1
through F12, and the arrow keys.
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CALLOUT PROPERTIES
Callout properties are used to highlight a specific portion of the screen.
They can only be applied to screen recordings. Unlike the previous
properties, Callout properties must be used with an action.
Figure 32. Callout Properties

Highlight

Callouts highlight an area of the recording in three different ways. Mouse
Cursor highlights a circular space around the mouse cursor. Foreground
Window highlights any window which is currently active. Freehand allows
you to draw the area you wish to highlight.

Opacity

The opacity slider controls the opacity of the space outside the callout. A
low value makes the surrounding area opaque while a high value makes
the surrounding area invisible.

Blur

This option blurs the content within the callout area. Use the slider to
change the degree of the blur effect.

Blur Background

Click to blur the area outside of the callout.

Zoom Up

This option magnifies the area inside the callout.

Border

This option increases the size of the callout to draw attention to a larger
area. This feature is not available with Freehand callouts.
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Outline

Adds an outline to the callout area. Use the field to enter the width of the
outline in pixels. This field accepts values ranging from 0 to 200.
Click the color box to change the color of the outline.

Shadow

Select this option to add a shadow behind the callout.
The slider represents a gradual loss in opacity as the shadow spreads
from the center. The value range for this option is 0-60.

Feather

This option blends the border of the callout to create a smooth transition
between the callout area and the surrounding space. The value range for
this option is 0-20.

Round

This option applies to Foreground callouts only. This rounds off the edges
of the callout to create a more gentle appearance. The value range for
this option is 0-200.

Build

This option sets the transition time of the callout. Duration In determines
the amount of build-in time to reach the full effect of the callout while
Duration Out determines the amount of build-out time to return to normal.
The value of these fields is in seconds.
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ANNOTATIONS PROPERTIES
Annotations are used for drawing simple shapes in your screencast.
Annotations operate as their own separate clip element in the timeline
and behave like an image element on the canvas. This allows you to
apply video properties and transitions to an annotations clip.
Figure 33. Annotations Properties

When you first create an annotation clip, you are given the option to draw
on the canvas. You can draw multiple shapes under the same annotation
clip and format these shapes individually, however any action applied to
this clip will apply to all shapes within the clip.

Shapes

Annotations are available in four shapes: circle, square, line, and arrow.

Color

This field changes the color, brightness, and opacity of the annotation.

Thickness

Determines the annotation line thickness. The value for this field is
represented in pixels and may be set from 2 to 300. The default is 50.

Shadow

Applies a shadow to your annotation. The slider represents a gradual loss
in opacity as the shadow spreads from the center. The value for this field
is represented in pixels and may be set from 1 to 60. The default is 25.

Outline

Applies an outline to the lines of the annotation. The slider represents the
thickness of the outline. The color is set by clicking the color field.

Endpoints

Applies a particular shape to the end of a line segment. The first and
second field represent the starting and finishing point of the line segment
respectively. Available shapes include none, arrow, circle, diamond, and
tapered. This option cannot be applied to circles or squares.
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TEXT PROPERTIES
This feature is for applying blocks of text to your screencast. Text boxes
operate as their own separate clip element in the timeline and behave like
an image element on the canvas. This allows you to apply video
properties and transitions to a text box.
Figure 34. Text Box on canvas

Click the Add Text Box button to add a text box to your timeline. This
appears on the top track of your timeline in the center with a duration of
five seconds and the word “Text” on display. If there is no room to place
this box, another track is added to the top of your timeline.
Figure 35. Text Clip on timeline

When you enter text in the text box, the name of the clip is changed in the
timeline to reflect this content.
Figure 36. Text Properties
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Text Properties

Font

Select this menu to choose from the list of fonts supported by your
system. Font changes may be applied to the entire text box or a range of
characters inside the box.

Size

Select this menu to choose the size of your text. Sizes are represented in
pixels and range from 9 to 288. Sizes may be applied to the entire text
box or a range of characters inside the box.
Use the Font Panel option to enter a custom size.

Alignment

This determines the alignment of the text within the text box. Available
options are align left, align right, and center.

Fill

This determines the color of the text within the text box. Color changes
may be applied to the entire text box or a range of characters inside the
box.
Deselect the checkbox to remove the file. This can be used with Outline
to create an characters which are transparent.
The menu allows you to choose between a solid color, image, or gradient.
Applying an image uses the color patterns represented in the image to fill
the text.
The color field below allows you to choose the color used in your text.

Outline

This applies an outline to the text in the text block.
Use the slider to set the width of the outline. The value is represented in
pixels and may be set from 0 to 15.
The color field sets the color of the outline.

Backdrop

This sets the text box background. Click the check box to remove the
backdrop.
Select the menu to choose between solid color or image.
Solid Color. Select the color field to set color and opacity.
Use the round field to smooth the edge of the text box. The value is
represented in pixels and the range for this field is 0 to 100. The default
value is 20.
Image. Choose this option to insert an image into the background.
Select the menu below to choose how the image fills the background
space. These options include Scale To Fit, Scale To Fill, Tile, Original
Size, and Stretch.
Margin. Use the slider to change the size of the margin in the backdrop.
The value is in pixels and ranged from 0 to 300. The default value is 25.
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MEDIA LIBRARY
The media library stores all recorded and imported media in an unaltered
state. This material may be dragged to your timeline or canvas for editing.
Dragging the content to the canvas or timeline more than once duplicates
the content.
You can also import media by dragging the media from Finder to your
media library or export media by dragging the media from your media
library to your desktop.
Media created by ScreenFlow is contained in the .scc format. This is a
proprietary format which can only be accessed by ScreenFlow.
Figure 37. Media Library

Rename

You can rename your media by highlighting the media, then clicking on
the name below. This renames all associated clips on the timeline unless
they have already been given a custom name.

Zoom

Use the Zoom slider at the bottom of this frame to change the display size
of the media. This is useful for organizing your media.

Add Media

Click to browse your hard drive for media to import into your ScreenFlow
project. This may include video files, audio files, or still images.

Add Recording

Click to create a new ScreenFlow recording. For more information, see
Adding A Recording (23).

Media Contact
Menu

Right-click (or Control-click) your media to open the contact menu.
Preview Source. Select to preview video, audio, or still image elements
stored in the media library.
Add to Timeline at Playhead. Select to add your media to the timeline
beginning at the scrubber.
Delete Media. Removes the media from your project. If the media is
present on the timeline, it is removed following a confirmation prompt.
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Media Library
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CHAPTER 5
Exporting
Presentations
When you are done editing your screencast, the third and final task is to
convert it to a standard video format for distribution or use in other
programs. If you intend to use your screencast in another application,
check the application documents to see which formats it supports.
ScreenFlow has two primary means of converting projects to video. You
may use the Export options to create standard video files or use the
Publish options for publishing your videos online.

Topics

Export (52)
Customize Settings (56)
Publish to YouTube (60)
Publish to Vimeo (62)
Publish to Flash (65)
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Export

EXPORT
The export feature produces standard video files for distribution or use in
other applications. This menu is accessible from File > Export. If you have
In and Out Points (33) set on your timeline, this option is rewritten as
Export Selected Range.
Figure 38. Export settings window

Save As

Enter the name of your screencast here. The default name is the same as
your project name. The file extension is applied automatically based on
your choice of preset.

Where

Select to determine the location of your video upon completion of export.

Preset

Export presets are settings designed for both general and specific use.
These settings are designed based on the most common needs of the
user.
Web - High | Web - High (Multi-pass). This is the default export option
which encodes using the H.264 codec. It was chosen as the default codec
based on balancing the demands of image quality and file size.
Web - Low | Web - Low (Multi-pass). This is an export option similar to
Web - High, but formatted for a low bandwidth. It plays more smoothly on
slow internet connections but the image quality is not as good as Web High.
Note: Multi-pass is a compression method that determines how best to
format the video based on predictive scanning of the source content.
This increases encoding time, but may improve image quality and
decrease file size.
Lossless. This is an uncompressed export format ideal for additional
editing. This format has the highest quality image but also the largest file
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size. When exported at 100%, the image quality is identical to the original
recording.
iPad / iPhone / Apple TV / iPod. These export options are formatted
based on the recommended video specifications for these devices. They
cannot be altered.
Windows Media. This option exports a video in the WMV format. This is
a popular format for Windows users. This option uses a QuickTime plugin
called Flip4Mac which must be licensed separately.
Make Settings Default. Select this option to enable your current setting
as the default export setting.

Customize

Click this button to make changes to your video and audio encoding
options. This option uses the standard QuickTime video compression
settings to customize your video with the exception of Windows Media
which uses the Flip4Mac video compression settings.
For more information, see Customize Settings (56).

Manage

Click this button to manage your available export presets.
Figure 39. Manage Presets window

Click the check box to the left of the preset to hide it. Click the Copy
button to the right of the preset to generate a custom preset copy.
Custom presets are displayed below. The custom preset name may be
changed by double-clicking the name field. Click the Edit button to
customize your preset.
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Export

Dimensions

These options are used to set the dimensions of your video export. You
should not set a size larger that your canvas size. This does not improve
image quality.
Figure 40. Dimensions: Scale to custom size settings

Scale by. Use this option to scale your project by a percentage value.
This is an easy way to shrink your screencast while maintaining the
aspect ratio.
Scale to custom size. Use this option to set the exact width and height
of your exported video. Click the Letterbox Content box to add
letterboxing to your export.

Use Motion Blur

This option uses a blurring algorithm to blend object movement smoothly
into the video. This is useful if you are using video properties effects to
move objects on the canvas.
This option increases encoding time so it should only be used if objects
are not moving smoothly in your exported video.

Add Chapter Track
from Markers

Use this option to add chapter markers to your exported video based on
the location and names of the markers in your screencast.
Presets which do not support chapter markers include iPad, iPhone,
Apple TV, iPod, and Windows Media.
Note: QuickTime X and VLC require a chapter marker on the first frame
of your project or it will move the chapter markers from their intended
locations. Be sure to set a chapter marker at the very beginning of your
project to prevent this.

Resulting Video
File Size

Screencast are very large . Your screencast is usually much larger than
the video you wish to produce. For example, if your original screen size
was 1280 x 800 pixels, you probably do not want to create a video of that
size. This would result in a large file size, and if you were to post it on a
website, many users would not be able to view it.
Reducing the size of the resulting video . To preserve the aspect ratio
of your screencast, use the Dimensions options. For general purposes,
you may wish to reduce the dimensions by 50%.:
Figure 41. Dimensions: Scale by setting

July 2011

Chapter 5 Exporting Presentations

ScreenFlow User’s Guide
Reduce the Frame Rate - Frames Per Second (FPS) . The National
Television System Committee video standard (NTSC) is defined with a
frame rate of 30 FPS. This is the standard for videos produced in North
America. However, this standard is based on creating a smooth
representation of motion in the real world and may not be necessary for
your screencast.
If you ask the codec to generate 30 frames per second, the output will be
smooth, but take up twice as much space as a 15 FPS recording. You
may find that a 10 FPS or 15 FPS recording is very acceptable for your
needs. Changing the frame rate can drastically reduce the size of the
resulting video file.
You should play with the output settings to get a feel for what frame rate
works best for you.
You can reduce the frame rate by pressing the Customize button in the
Export dialog, then press Settings in the Video area. Most codecs offer an
FPS or Frame Rate setting.
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Customize Settings

CUSTOMIZE SETTINGS
After selecting a preset, click the Customize button to modify it. This
presents the QuickTime compression settings window. This is the
standard window for all programs which use QuickTime to compress
video.
If you are customizing the Windows Media preset, you are presented with
the Flip4Mac compression settings window.
You can also access this window by creating a custom preset using
Manage > Edit.

QuickTime
Customization

Unless you are using the Windows Media preset, ScreenFlow displays
the standard QuickTime compression settings window. This window is
used by most programs which access QuickTime to compress video.
Figure 42. QuickTime compression window

Video. Uncheck only if you want your export not to contain video content.
Settings. Click Settings to change the video codec and its settings. Each
codec has its own set of options controlling frame rate, bit rate, quality,
etc.
Filter. Check to add effects such as Sharpen, Sepia, Gamma (Adjust)
and others. Using filters increases the time it takes for ScreenFlow to
render the video file.
Size. Check to specify the frame size directly in the codec.
Although you can configure the size directly in the codec, Telestream
recommends that you retain the default setting (Current). Instead, specify
the frame size in Dimensions (54) to modify the resulting size of the
movie.
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Resizing increases the time it takes for ScreenFlow to render the video
file.
Sound. Uncheck only if want your export not to contain audio content.
Settings. Pressing this button allows you to change the audio codec and
its various settings. Each codec has its own set of options, controlling
frame rate, bit rate, quality, etc.
Prepare for Internet Streaming. There are several ways you can export
your movie for use on the internet:
Fast Start Allows your movie to begin playing before the movie has
finished downloading. This is the default option.
Fast Start—Compressed Header Same as the Fast Start option, but
compresses the header of the file.
Some older versions of QuickTime do not support this option, and
therefore some users may not be able to view this format.
Hinted Streaming Use this option if the video will be hosted on a
QuickTime Streaming Server (QTSS). This option adds “hint tracks” which
allow QTSS to stream the movie.
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Flip4Mac
Customization

For Windows Media exports, ScreenFlow uses the Flip4Mac plugin for
QuickTime. This plugin must be licensed separately for full functionality. If
Flip4Mac is not licensed, it functions in demo mode to provide a sample of
its capabilities.
To export a full length Windows Media file, Flip4Mac requires a minimum
upgrade of Flip4Mac WMV Studio. Customization beyond the preset
profiles requires a minimum upgrade of Flip4Mac WMV Studio Pro.
For more information, see Flip4Mac on the Telestream Web page.
Figure 43. Flip4Mac compression window

Profiles. This menu features a list of preset encoding options for
Windows Media.
Video. The video tab customizes the video content in your export.
Export Using Choose between WMV 9 Standard or Advanced (VC-1)
Coding Method Choose between one-pass or two-pass encoding and
constant bit rate or variable bit rate. Two-pass encoding requires
Flip4Mac WMV Studio Pro HD.
Quality Move the slider to set the quality value of the encoded video as it
relates to smoothness versus sharpness.
Bit rate Set to determine the average bit rate of your video. This applies a
baseline for the amount of data to be processed per second while playing
your video. A high bit rate allows more complex information which may
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increase quality while a low bit rate limits the amount of data, which
reduces file size and plays more smoothly on a low bandwidth selection.
Peak bit rate Set to determine the maximum bit rate when using the VBR
Constrained option.
Size Set to determine the resolution of your encoding. Available frame
sizes are dependent on your Flip4Mac license.
Although you can configure the size directly in the codec, Telestream
recommends that you retain the default setting (Current). Instead, specify
the size in Dimensions (54) to modify the resulting size of the movie.
If you set a frame size which is not supported by your Flip4Mac license,
the plugin defaults to the closest available frame size.
For more information, see Flip4Mac technical specifications.
Rate Choose to select the frame rate of your video. Frame rate standards
are 30 (NTSC) and 25 (PAL), however for screencasts, you may be able
to use an exceptionally low frame rate without noticing a loss of quality.
Advanced This section features advanced encoding techniques including
complexity, profile, key frame distance, B-frame distance, buffer delay,
and interlacing options.
Audio. The audio tab is used to customize the audio content in your
export.
Export Using Choose between WMV 9 Standard, Professional, or
Lossless
Coding Method Choose between one-pass or two-pass encoding,
constant bit rate or variable bit rate, mono or stereo, and various sample
rates.
Advanced Set buffer delay.
Content. This tab is used to set the metadata on your Windows Media file
including title, author, description, copyright, and rating.
Silverlight. This tab is for encoding your Windows Media file for use with
Microsoft’s Silverlight player. Here you may select from various player
skins to customize your video presentation.
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PUBLISH TO YOUTUBE
If you have a YouTube account, ScreenFlow enables you to publish your
screencasts directly to YouTube.

Logging In

Select File > Publish to YouTube to access the login window
Figure 44. YouTube Account Login window

Enter your YouTube Name and Password to access your account. Select
the check box to retain your login information for future uploads.
Upon clicking the Sign In button, ScreenFlow displays a dialog for you to
details about your screencast:

Settings

Figure 45. YouTube details window

Note: All fields must be completed to activate the Publish button.
Category. Select the category of your screencast from the options in the
dropdown menu.
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Title. Enter the title for your screencast. By default, this field uses your
project name.
Description. Enter a description for your screencast.
Tags. Enter keywords to describe your screencast. When YouTube users
search for these words, your video is included in the search results.
Access. Check to mark your screencast as personal. Personal content
can only be viewed from your account and other YouTube users that you
authorize.
Quality. Select this option to publish your screencast in HD. YouTube
supports both 720p and 1080p for upload. If this option is not checked,
the resolution of the video is set to 360p.
Publish. Click Publish to export and upload your screencast.
ScreenFlow displays a progress bar to indicate encoding and upload
progress. Click Cancel at any time to abort the encode/upload process.
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PUBLISH TO VIMEO
ScreenFlow also includes the option to publish directly to the video
hosting site Vimeo. If you do not have a Vimeo account, you are prompted
to create one.
Figure 46. Vimeo Log In window

Setting up your
account

Click the Join Vimeo button to create a Vimeo account. Choose Basic or
Plus to determine the type of Vimeo account you wish to set up.
Figure 47. Vimeo Account window
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After you have chosen your account preference, enter your first and last
name, e-mail, and password to create your account.
Figure 48. Join Vimeo window

After your account has been created, you must authorize ScreenFlow to
publish directly to your account.
After accessing your account, Vimeo prompts you to authorize the
application to upload directly to your Vimeo account. Click “Yes, authorize
ScreenFlow!” to enable Vimeo uploads.
Figure 49. Vimeo Authorization window
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Verify account

Figure 50. Vimeo Account Verification window

Vimeo Account. This displays your currently accessed Vimeo account.
Remember login in my keychain. Select this option to retain your
account information when uploading to Vimeo.
Change Account. Click this button to access a different Vimeo account.

Settings

Figure 51. Vimeo Settings window

Title. Enter the title for your screencast. Default uses your project name.
Description. Enter a description for your screencast.
Tags. Enter keywords to describe your screencast. When Vimeo users
search for these words, your video is included in the search results.
Access. Check to mark your screencast as personal for authorized
viewing only. The default option uses your Vimeo preferences.
Quality. Select this option to publish your screencast in HD. Maximum
resolution is 640x480, if unchecked, and 1280x720, if checked.
Publish. Click Publish to export and upload your screencast.
ScreenFlow displays a progress bar to indicate encoding and upload
progress. Click Cancel at any time to abort the encode/upload process.
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PUBLISH TO FLASH
This feature enables the user to save their screencast in the F4V Flash
format. This is a highly compressed format most suitable for internet
publication.
This feature produces both a Flash video and the necessary components
for hosting the video on your website.
After selecting the Publish to Flash option, you are presented with a
settings dialog.
Figure 52. Flash settings window

Save As

Enter the name of your screencast here. The default name is the same as
your project name. The file extension is applied automatically based on
your choice of preset.

Where

Select to determine the location of your video after encoding.

Player

Choose between three standard Flash player skins to determine how the
video controls are presented on your web site.

Encoding:
Automatic for Web

Select this option to use the automatic Flash presets. This formats the
video as 320 x 240, 30 FPS, and 900 KPBPS.

Encoding: Custom

Width. This field determines the width of your video in pixels.
Height. This field determines the height of your video in pixels.
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Frame Rate. This field determines the number of frames in your video per
second. The North American NTSC standard is 29.97 (often rounded up
to 30) while the European PAL standard is 25. The range for this field is 1100.
Data Rate. Data rate sets the amount of information required to process
the video per second. Setting a low data rate is ideal for streaming with
slow internet connections, but a low data rate may impair image quality.
An acceptable data rate depends on the content of the video and user
preference. The range for this field is 10 to 10,000.

Contents of Flash
folder

This feature produces a Flash folder consisting of:

• index.html, an HTML page containing a player showing movie.f4v. You
may edit this file to suit your design requirements, or use it as a template for incorporating the video in a different Web page.

• movie.f4v, the screencast published in Flash
• player.swf, the player itself
• a /com directory containing the skin for the player
• README.txt.

How to Publish

If you have a web server on the same machine as ScreenFlow, you can
place the output directory in (a subdirectory of) /Library/WebServer/
Documents/ and have your video immediately accessible to the world.
Example: If you have placed your output in /Library/WebServer/
Documents/prettyvideo/ on webserver.comp.com, opening http://
webserver.comp.com/prettyvideo/ in a web browser will show your video.
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Preferences

ScreenFlow Preferences contains many options for customizing the
application to suit your specific needs.

Topics

General (68)
Timeline (69)
Advanced (70)
Licenses (71)

68

General

GENERAL
The General pane features customizable options for various functions of
the program.
Figure 53. Preferences General pane

Settings

Show ScreenFlow options in menu bar. Click this option to toggle the
ScreenFlow Helper (22) menu on or off.
Countdown for [x] secs before recording. Use this option to set the
countdown time between zero and ten seconds. Deselecting this option
results in a countdown time of zero. The default value is 5.

Startup

Launch ScreenFlow Helper at user login. Select this option to have
ScreenFlow Helper active and available the moment you open your
computer. This allows you to access ScreenFlow’s recording features
prior to launching the program.

Auto Update

Check for ScreenFlow updates at launch. Select this option to check
for periodic software updates when the application is launched. If a new
version is available, you are given the option to update.
Note: This option is not available to users who purchased from the Mac
App Store. The App Store has its own updating procedure.

Recording Hotkey

Use this field to set a recording hotkey command. Default is ShiftCommand-2. Be careful to choose a hotkey which is not already in use by
any application you are demonstrating.

Pause Hotkey

Use this field to set a pause hotkey command. Be careful to choose a
hotkey which is not already in use by any application you are
demonstrating.
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TIMELINE
The Timeline pane is used to set default preferences for common
workflows in the timeline.
Figure 54. Preferences Timeline pane

Display

Use SMPTE timecode. Use this option to display the timeline scale as
SMPTE timecode (e.g. HH:MM:SS:FF or Hour:Minute:Second:Frame). If
this option is not set, the scale uses a more informal method of displaying
time markers (i.e. 1h2m30s).
Show current time when scrubbing. Select to display exact time when
moving the scrubber across the timeline.

Default Transition

Choose the default effect used when generating a transition. ScreenFlow
includes sixteen different transition effects. The default setting is Bars
Swipe.

Default Track
Height

Choose to set the default track height for tracks on the timeline. This
effects how much vertical space is used in the timeline when creating a
project. If you are using many tracks, you may want to set this to small.
The default setting is Regular.

Default duration of
still images

Use this option to set the default temporal length of a still image when
placed on the timeline. This may be set anywhere from one-tenth of a
second (or 3 frames) to 50 seconds. The default setting is 5 seconds.
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ADVANCED
The Advanced pane features customizable options which relate to
advanced preferences.
Figure 55. Preferences Advanced pane

Video
Magnification

Choose between Smooth and Sharp to set the compression algorithm
used when computing a scale effect or zoom callout. Smooth blurs color
values to create a smoother transition where as Sharp does not blur color
values to create more defined lines in the transition. The default setting is
Smooth.

Screen Recording
Compression

This setting is used to determine the method of compression used in
recording the video. Adaptive uses a compression method which
recognizes elements of the display which do not change thereby resulting
in a smaller file size. Lossless uses an uncompressed recording method
which does not record content based on changes thereby resulting in a
larger file size.
The default setting is Adaptive. This setting is recommended because the
Lossless setting rarely results in better quality, but always results in a
larger file size.

Computer Audio

Use this button to install and uninstall ScreenFlow’s computer audio
driver. This driver is necessary for recording system audio.
Note: If you purchase ScreenFlow through the App Store, this setting is
not available. The computer audio driver installs automatically.

Capture Scratch
Disk

Click the Change button to set your capture scratch disk location. This
determines where ScreenFlow recordings are placed as they are being
created. If your recording is interrupted for any reason, you can find it in
the capture scratch disk location.
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LICENSES
Note: This does not apply to users who purchased from the Mac App
Store. The App Store has its own installation and licensing procedure.
This pane is used for setting your license. ScreenFlow must be licensed
to fully enable the export capabilities. If ScreenFlow is not licenses, all
exports are watermarked.
The functions of this pane are locked to administrator access to prevent
guests from removing your license. Click the lock at the bottom of the
window to make changes.

Unlicensed

If ScreenFlow is not currently licensed, this pane displays the buttons in
the manner demonstrated in the following image.
Figure 56. Preferences Licenses pane (unlicensed)

Purchase License. Click this button to purchase a ScreenFlow license
from the Telestream web site. This license is automatically installed upon
completion of your purchase.
Enter Serial Number. Click this button to enter a serial number which
has already been issued. This field is case sensitive. All letters must be
capitalized and hyphens must be included.
Deactivate Serial Number. If ScreenFlow is unlicensed, this option is
dimmed and inaccessible.
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Licensed

If ScreenFlow is licensed, this pane displays the buttons in the manner
demonstrated in the following image.
Figure 57. Preferences Licenses pane (licensed)

Upgrade License. Click this button to upgrade your ScreenFlow license
from version 1.0 or 2.0 to 3.0, thereby enabling full access to ScreenFlow
3.0. The upgrade fee depends on which license you have installed.
Change Serial Number. Click this button to license a different serial
number for use with ScreenFlow.
Deactivate Serial Number. Click this button to deactivate your
ScreenFlow license. This allows you to use your license on a different
computer. Please allow up to 15 minutes before re-activating this serial
number as it may take time to process the deactivation.
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APPENDIX A
Installing ScreenFlow

This section describes how to install, upgrade, or uninstall ScreenFlow,
and to install or uninstall Telestream Audio.

Topics

System Requirements (74)
Installing ScreenFlow (75)
Upgrading ScreenFlow (76)
Installing Telestream Audio (77)
Removing ScreenFlow from Your Computer (78)
Note: Be sure to review your platform requirements before installing
ScreenFlow.

74

System Requirements

SYSTEM REQUIREMENTS
Mac OS X Snow Leopard 10.6.7 or later
Intel-based CPU required. Core 2 Duo recommended.
A supported programmable GPU required for certain effects & functionality
Note: Cameras using the HDV codec are not supported.
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INSTALLING SCREENFLOW
Note: This does not apply to users who purchased from the Mac App
Store. The App Store has its own installation and licensing procedure.
ScreenFlow is available from www.telestream.net as a disk image file
(dmg).
When you download or open the dmg file with Safari, Mac OS X
automatically mounts the disk image (if necessary) and runs the installer.
When you download a dmg file using another Web browser, mount the file
yourself. Then, double-click it to run the installer.
Note: You will be prompted for an administrator name and password
during installation. If you do not have an administrative account, you will
need to obtain one in order to continue.
Note: The installer will attempt to close QuickTIme, Final Cut Pro,
Episode Desktop, and Pipeline Control before installing the software. If
any of these applications cannot be closed (for example, because they
have an open document that hasn't been saved) installation will fail after
about a minute (unless you click Save or Discard during this time to
close the application).
When the installer runs, it displays the following window:
Figure 58. Installing ScreenFlow

Drag the ScreenFlow icon (right panel) onto your Applications folder to
install ScreenFlow.
If a previous version is in the Applications folder, the Finder displays a
Copy dialog, asking you to confirm that you wish to replace the
ScreenFlow file. Click Replace to complete installation.
Close the installer – ScreenFlow is installed and ready for you to use.
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UPGRADING SCREENFLOW
Note: This does not apply to users who purchased from the Mac App
Store. The App Store has its own installation and licensing procedure.
If you currently have a license for ScreenFlow 1.0 or 2.0, this license will
not work in 3.0 and you will be required to upgrade your license in order to
activate ScreenFlow 3.0.
1. To upgrade your license, go to ScreenFlow > Preferences > Licenses
2. Click the Lock icon at the bottom of the panel, and enter your

password to allow ScreenFlow to make changes to your license.
Note: Your user must be an administrator. If your username is not an
administrative account, you’ll need to create one in order to continue.
3. Click Upgrade License. This will redirect you to the Telestream online

store where you will receive an upgraded license at a discount price.
4. Upon completing your purchase, the new license is automatically

installed and activated.
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INSTALLING TELESTREAM AUDIO
To capture computer audio, ScreenFlow must install the Telestream Audio
driver.
The installation process will begin automatically if you attempt to record
computer audio without the driver installed.
1. Go to ScreenFlow > Preferences > Advanced
2. Click the Install Driver button.
3. This will open the Install Telestream Audio dialog using the Installer

application. Click Continue to proceed.
4. A message will notify you that the driver will require 172 KB of space

on your hard drive. Click Install to continue.
5. You must enter your password to install the driver. Click OK to

continue.
Note: Your user must be an administrator. If your username is not an
administrative account, you’ll need to create one in order to continue.
6. The Telestream Audio driver will now install. Upon completion of

installation, you will be notified that installation was successful. Click
Close to close this window.

Uninstalling
Telestream Audio
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To uninstall the audio driver, click the Uninstall Driver button. This will
require you to enter an administrator username and password.
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Removing ScreenFlow from Your Computer

REMOVING SCREENFLOW FROM YOUR COMPUTER
To uninstall ScreenFlow, simply move the ScreenFlow application to the
trash. The ScreenFlow license is stored separately, so you do not need to
re-activate your license when you reinstall ScreenFlow.
To completely remove from your system ScreenFlow, move the following
files to your trash:

• /Applications/ScreenFlow
• /System/Library/Extensions/TelestreamAudio.kext
• /Library/Preferences/net.telestream.screenflow.plist
• ~/Library/Preferences/com.vara.screenflow.LSSharedFileList.plist
• ~/Library/Preferences/com.vara.screenflow.plist
• ~/Library/Preferences/com.vara.screenflowhelper.plist
• ~/Library/Preferences/net.telestream.screenflowapp.LSSharedFileList.plist

• ~/Library/Preferences/net.telestream.screenflowapp.plist
• ~/Library/Preferences/net.telestream.screenflowhelper.plist
Note: Some of these files may not be present if the associated features
were not used.
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APPENDIX B
Using ScreenFlow
Menus
This chapter describes ScreenFlow’s menus.

Topics

ScreenFlow Menu (80)
File Menu (81)
Edit Menu (83)
Insert Menu (89)
Font Menu (90)
Actions Menu (92)
View Menu (93)
Window Menu (95)
Purchase Menu (96)
Help Menu (97)

80

ScreenFlow Menu

SCREENFLOW MENU
This topic describes each item in the ScreenFlow menu.

About ScreenFlow

Displays a dialog indicating the version of ScreenFlow you are running.

Check For Updates

Note: This option is not available to users who purchased from the Mac
App Store. The App Store has its own update procedure.
Checks Telestream’s Online Store to determine if there is a more recent
version of ScreenFlow available. If so, you can download it.
To update automatically, see Auto Update (68).

Preferences
(Command-,)

Opens the Preferences (67) window so that you can view and change
ScreenFlow preferences. If the Preferences window is already open, it is
brought to the front.

Services

Displays Macintosh Services – none are implemented in ScreenFlow.

Hide ScreenFlow
(Command-H)

Hides all ScreenFlow windows.

Hide others
(Alt-Command-H)

Hides all other application windows (every window which is not a
ScreenFlow window).

Show All

Shows all previously hidden windows.

Quit ScreenFlow
(Command-Q)

ScreenFlow closes all open documents and then quits. If a document has
not been saved, ScreenFlow displays a Save dialog, so you can save the
document first.
If Launch ScreenFlow Helper at user login (68) is checked in Preferences,
ScreenFlow Helper (22) stays running when you quit ScreenFlow.
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FILE MENU
This topic describes each item in the File menu.

New Recording
(Command-N)

Displays the Configure Recording (20) dialog, which allows you to select
recording options and record a new clip. When complete, the clip is added
to a new, untitled document if no document is open, or if one or more
documents are open, you can choose to create a new document or add it
to an open document.

New Empty Document
(Shift-Command-N)

Displays a new, untitled ScreenFlow document.

Open
(Command-O)

Displays the Open dialog, so you can navigate and open a ScreenFlow
document that was saved earlier.

Open Recent

Click to select from up to 15 recently accessed documents.
Every time you open or save a document, it is entered into the Open
Recent list. You can select “Clear Menu” from the “Open Recent” menu to
reset the list.

Add Additional
Recording
(Shift-Command-R)

Configures a new recording to be added to a currently open document.

Close
(Command-W)

Closes the active ScreenFlow document. If the document has never been
previously saved, ScreenFlow displays a Save As dialog, so you can
name the document, then save the document in the desired folder before
closing it.

OS X Lion Save
Commands

Due to the introduction of new file save features in OS X 10.7 Lion,
ScreenFlow save features are different depending on which operating
system is used. The following save options are specific to OS X Lion.

For more information, see Adding A Recording (23)

Save a Version
(Command-S)

Saves the document with recent changes. If the document has never
been previously saved, ScreenFlow displays a Save As dialog, so you
can name the document, then save the document in the desired folder.

Duplicate

Saves a new version of the document without overwriting the previous
version. This allows you to save the project with a new name and/or
location.

Revert to Saved

Restores the document to the state it was in when last saved. This will
undo any action taken since the last save.
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OS X Snow
Leopard Save
Commands
Save
(Command-S)
Save As
(Shift-Command-S)

Mac OS X 10.6 Snow Leopard does not have the same save functionality
as OS X 10.7 Lion. The following save commands are specific to OS X
Snow Leopard.

Saves the document with recent changes. If the document has never
been previously saved, ScreenFlow displays a Save As dialog, so you
can name the document, then save the document in the desired folder.
ScreenFlow displays a Save As dialog, so that you can rename the
document with a new name, then save the document in the desired folder.
If you have previously saved your document, this duplicates the
document and does not alter the original.

Publish to YouTube

Displays the Publish to YouTube (60) dialog, so you can log in to your
YouTube account, encode your screencast and publish your video.

Publish to Vimeo

Displays the Publish to Vimeo (62) dialog, so you can log in to your Vimeo
account, encode your screencast and publish your video.

Publish to Flash

Displays the Publish to Flash (65) dialog, which you use to encode your
encode your screencast in Flash (F4V) format and save the file.

Export
(Command-E)

Displays the Export (52) dialog, which you use to select your encoding
options, encode your screencast and save the file.
If you have In and Out Points (33) set on your timeline, this option is
rewritten as Export Selected Range.
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EDIT MENU
This section describes each item in the Edit menu.

Undo
(Command-Z)

Reverts your last change. ScreenFlow offers an unlimited number of
undo/redo actions (limited only by memory constraints). However, undo
information is stored on a per-window basis. If you close a window and
then reopen it, your undo information for that window is lost.

Redo
(Shift-Command-Z)

Reverts your last Undo action.

Cut
(Command-X)

Select Cut to remove these selected elements:

• Removes selected text in a Text Properties (47) box, and places it on
the clipboard.

• Removes the selected clips from the Timeline (32), and places them
on the clipboard.

Copy
(Command-C)

Select Copy to duplicate these selected elements:

• Duplicates selected clips in the Timeline (32), and places the copy
onto the clipboard for pasting later.

• Duplicates selected text in a text box, and places the text onto the clipboard for pasting later.
Note: Clips in the Media Library (49) cannot be copied, but may be
imported into the timeline multiple times.

Paste
(Command-V)

Select Paste to add clips and text from the clipboard to your document:

• Pastes copied text into the text box at the cursor position. When you
paste text, it retains its formatting. (See Paste and Match Style (AltShift-Command-V) (84)).

• Pastes the copied clip onto the timeline starting from the scrubber, in
the same track as the original clip, as shown below:
Figure 59. Timeline just prior to a clip Paste operation
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Select Paste to add the clip on the clipboard to the timeline:
Figure 60. Timeline after pasting a clip from the clipboard

If the clip is pasted again, a new track is created for each new copy.

Paste Properties

Select Paste Properties to update the properties of the selected clip in the
timeline with the properties of the current clip on the clipboard.
Video (Alt-Command-I) . Pastes Video Properties (38) on a clip.
Audio (Alt-Command-A). Pastes Audio Properties (40) on a clip.
Screen Recording (Alt-Command-S). Pastes Screen Recording
Properties (42) on a clip.
Callout (Alt-Command-C). Pastes Callout Properties (44) on a Callout
action.
Note: You can paste adjustments to multiple clips simultaneously;
however, If you copy multiple clips with different properties and paste
adjustments to another clip, which properties will be pasted is not
predictable.

Paste and Match Style
(Alt-Shift-CommandV)

Select Paste and Match Style to add text on the clipboard to your text box.
Inserted text adopts the text formatting of the character immediately
preceding the insertion point.

Delete
(Backspace)

Select Delete to permanently remove the currently selected objects.
Delete does not place the object on the clipboard.
If you have marked In and Out Points (33), the segment between the In
and the Out point is deleted for all clips, as shown below:
Figure 61. Mark In and out points on your timeline
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Select Delete to remove all assets from the timeline between the in and
out points:
Figure 62. Delete the assets between the in and out points

Note: To shift the clips left to fill the hole created by the deletion, use
Ripple Delete (Command-backspace), the scrubber handle, or right-click
(CTRL-click) in the empty space and choose Close Gap. See Create or
close a gap in the timeline (33).

Select All
(Command-A)

Choose Select All to highlight all clips in the timeline.

Deselect All
(Shift-Command-A)

Choose Deselect All to deselect all clips in the timeline. This can also be
done by clicking in an empty area of the canvas or timeline.

Split Clip
(T)

Select Split Clip to convert each selected clip into two separate clips,
splitting them at the current scrubber point, so that you can adjust the
parts of the clip independently.
Figure 63. Timeline before splitting a clip

Figure 64. Timeline after splitting a clip

When splitting a clip, the previous clip name is retained on both clips. By
default, each segment of a clip uses the name of the original media
located in the Media Library (49). These segments can be renamed for
convenience and clarity.
This action is applied with Command-T, Command-Shift-T, or simply T.

Detach Audio
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Select Detach Audio to remove the audio stream from the selected clip
(visible as a green waveform through the center of the clip unless View >
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Show Audio Waveforms is unchecked), and create a new audio clip,
creating an independent audio clip at the same point in the timeline.
Figure 65. Timeline just prior to a clip Detach Audio operation

ScreenFlow adds the audio to a new audio clip in the timeline:
Figure 66. Timeline after detaching audio from a clip

After the operation, a new audio clip, which contains the audio from the
selected video clip, is added to the timeline. The previous video/audio clip
is now video only.

Add Freeze Frame
(Shift-Command-F)

Select Add Freeze Frame to insert a freeze frame in the middle of a
selected clip. First, the clip is split at the scrubber, then a two second
freeze frame is inserted between the clips. The duration of the freeze
frame can be set by dragging the edge of the clip, much like any other still
image element. The second half of the clip is moved to the right to adjust
for the added element.
Figure 67. Timeline just prior to a Add Freeze Frame operation

ScreenFlow adds two new clips to the timeline:
Figure 68. Timeline after detaching audio from a clip

This is useful for pausing your video while demonstrating or narrating.
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Trim Front to
Scrubber
(W)

Select Trim Front to Scrubber to trim the front of the selected clips from
the start of the clip up to the scrubber position.

Trim End to Scrubber
(E)

Select Trim End to Scrubber to trim the back of the selected clips from the
end of the clip up to the scrubber mark.

Alternatively, you can adjust the left side of the clip by clicking the mouse
just near the left edge of the clip (the mouse pointer changes to the drag
cursor [left]) to indicate that you can resize the clip. Click and drag the
edge of the clip to the right to trim the amount you want off of the front of
the clip. This method is functionally equivalent to using the Trim Front to
Scrubber command.

Alternatively, you can adjust the right side of the clip by clicking the mouse
just near the right edge of the clip (the mouse pointer changes to the drag
cursor [left]) to indicate that you can resize the clip. Click and drag the
edge of the clip to the left to trim the amount you want off of the back of
the clip. This method is functionally equivalent to using the Trim End to
Scrubber command.

Lock Clip/Unlock Clip
(Alt-Command-L)

Select Lock Clip/Unlock Clip to lock selected clips which are locked to
their positions in the timeline and cannot be moved. (When clips are
locked, you cannot move other clips onto them to make Transitions (36).)
Apply again to unlock selected clips you have previously locked.

Add Starting
Transition/Remove
Starting Transition

Select Add Starting Transition/Remove Starting Transition to add
Transitions (36) to the beginning of the selected clips. Apply again to
remove the transition.

Add Ending
Transition/Remove
Ending Transition

Select Add Ending Transition/Remove Ending Transition to add
Transitions (36) to the ending of the selected clips. Apply again to remove
the transition.

Ripple Delete
(CommandBackspace)

Select Ripple Delete to delete the content between the in and out points
on all tracks of the timeline and shift all clips left to close the gap in the
timeline.

Mark In Point
(I)

Select Mark In Point to set the in point of a range in the timeline at the
current point of the scrubber. When you create an in point without an out
point, ScreenFlow automatically sets the out point to the end of the last
clip in the timeline, and highlights the range in blue. In and out points can
be used to delete entire sections of your timeline using the Ripple Delete
command.
Select the in point (click on the line directly over the timeline scale) and
drag it right or left to adjust its point on the timeline.
Shift-click on the timeline scale to set in and out points relative to the
position of the scrubber.
See In and Out Points (33)
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Mark Out Point
(O)

Select Mark Out Point to set the out point of a range in the timeline at the
current point of the scrubber. When you create an out point without an in
point, ScreenFlow automatically sets the in point to the beginning of the
timeline, and highlights the range in blue. In and out points can be used to
delete entire sections of your timeline using the Ripple Delete command.
Select the out point (click on the line directly over the timeline scale) and
drag it right or left to adjust its point on the timeline.
Shift-click on the timeline scale to set in and out points relative to the
position of the scrubber.
See In and Out Points (33)

Clear In & Out Points

Select Clear In & Out Points to remove the In and Out Points (33) you
created earlier.

Markers

Add (‘). Select to add a marker to the timeline at the scrubber location.
If you export a ScreenFlow document as a QuickTime movie, Chapter
Markers are placed at each named marker position in the movie using
Add Chapter Track from Markers (54).
Delete (Shift-~). Select to delete the selected marker.
Delete All. Select Markers > Delete All to delete all markers in the
timeline.
Goto Next (Shift-Up Arrow). Select to move the scrubber to the next
marker to the right on the timeline.
Goto Previous (Shift-Down Arrow). Select to move the scrubber to the
previous marker to the left in the timeline.
You can also use the mouse to drag markers and adjust their position.

Special Characters

Displays the Characters window so that you can enter special characters
in text fields.
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INSERT MENU
This section describes each item in the Insert menu.

Text Box

Select Text Box to insert a Text Properties (47) clip into the timeline at the
current scrubber position. Text box duration is five second, but can be
adjusted by dragging the edge of the clip in the timeline.

Speech Clip

Select Speech Clip to create an audio clip by converting text to speech
using one of six automated voice programs. Text may be typed directly
into this field or pasted from another document.

Choose
(Shift-Command-V)

Select Choose to import media files from your hard drive into your
screencast at the current scrubber position.
ScreenFlow displays the Open dialog, so that you can browse your file
system and select the media to add.
The selected media file is added to the Media Library as well as the
timeline.
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FONT MENU
This section describes each item in the Font menu. The font options are
only for use with a Text Properties (47) box.

Show Fonts
(Command-T)

Shows the System Font Panel. This Font Panel applies to the any
highlighted text.

Bold
(Command-B)

Makes the current text selection bold.

Italic
(Command-I)

Makes the current text selection italic.

Underline
(Command-U)

Underlines the current text selection.

Bigger

Increases by one point the font size of the current text selection.

Smaller

Decreases by one point the font size of the current text selection.

Kern

Kerning means adjusting the distance between glyphs (characters) in text
to make it look better balanced, for example “tucking in” the A under the V
in AV. “Kern” applies to all selected text in a text box. If no characters are
selected but the insertion cursor is placed between two characters, “Kern”
applies to that pair.
“Kern” has the following submenu options:
Use Default. Use the default kerning built into the font.
Use None. Turn off all kerning.
Tighten. Decrease the distance between characters.
Loosen. Increase the distance between characters.

Ligature

A ligature is a character that combines two or more other characters. For
example the ligature fi combines f and i. Not all fonts contain all ligature
characters, but their use is turned on by default in ScreenFlow.
“Ligature” has the following submenu options:
Use Default. Use ligatures if the font uses them.
Use None. Do not use ligatures.
Use All. Use ligatures.
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Copy Style

Copies the Text style of the selected text. This does not copy the
background of the text as the background is for the whole Text Box.

Paste Style
(Alt-Command-V)

Applies the previously copied Text Style to the currently selected text.
This does not paste the background of the text as the background is for
the whole Text Box.

Make Text Properties
Default

Saves all the current text properties for the selected Text Box clip and
make them the default. When you create a new Text Box, the default text
properties are used.
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ACTIONS MENU
This section describes each item in the Actions menu. Actions are timebased changes to clip properties used to create gradual or temporary
effects. A clip must be selected for the items in this menu to be active.
Actions are described in detail in Actions (37).

Add Video Action
(Command-K)

Adds a Video Action to the selected clip. A Video Action allows you to
apply effects like Zoom, Pan, and Rotate to your video clip. See Video
Properties (38)

Add Audio Action
(Alt-Command-U)

Adds an Audio Action to the selected clip. An Audio Action allows you to
apply various effects on the audio of the selected clip, such as muting,
ducking, or adjusting the volume. See Audio Properties (40).

Add Screen
Recording Action
(Command-R)

Adds a Screen Recording Action to the selected clip. Screen Recording
Actions can only be applied to screen recordings. For example, you can
modify the size of the Mouse Pointer, add click effects, or show keys
pressed. See Screen Recording Properties (42).

Add Callout
(Command-L)

Adds a Callout to the selected clip. A callout lets you focus attention on a
section of your screencast. For example, you can highlight the Mouse
Pointer by dimming everything but the area just around the Mouse Pointer
or highlight and magnify the foreground window. Callout actions can only
be applied to screen recordings. See Callout Properties (44).

Add Annotations
(Alt-Command-T)

Adds simple graphic effects to existing image files including recordings,
videos, and image files. Annotation shapes include circle, square, line,
and arrow. See Annotations Properties (46).

Goto Next Action

Within a clip, this selects the next action.

Goto Previous Action

Within a clip, this selects the previous action.

Curve Type

By default, actions are applied to the clip in a linear manner. For example,
when applying a scaling action, the image size changes by equal
amounts from start to finish. This may be perceived as too abrupt, so you
can modify the rate with which an action is applied.
Curve Type has the following submenu options:
Default. Linear transition.
Ease-In. Starting slow, speeding up towards the end.
Ease-Out. Starting fast, slowing down towards the end.
Ease-In & Out. Starting and ending slowly, faster in the middle.
None. Apply action immediately. The duration of the action is ignored if
this option is applied.
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VIEW MENU
This section describes each item in the View menu. View options apply to
how the media is presented both on the Canvas (30) and in the Timeline
(32).

Enter Full Screen
(Command-F)

Only available in OSX 10.7 - Lion. Displays the editing window in full
screen mode to reduce on-screen clutter.

Enter Preview
(Alt-Command-F)

Displays the screencast in full screen mode for playback only. Press
Escape to exit preview.

Zoom In
(Command-=)

Magnify the canvas area of ScreenFlow.

Zoom Out
(Command--)

Reduce the canvas area of ScreenFlow.

Zoom to 100%
(Alt-Command-0)

Magnify the canvas area of ScreenFlow to its natural size.

Zoom to Fit

Magnify the canvas of ScreenFlow so that all contents are visible in the
window with a bit of margins on the sides.
These options only change how your screencast is displayed on the
canvas. They do not alter the media.
For details on how to crop the canvas, see Canvas Controls (30).

Zoom Timeline to Fit
(Control-T)

Scales the timeline to fit all content in your window.

Zoom Timeline In
(=)

Expands the timeline.

Zoom Timeline Out
(-)

Contracts the timeline.

Snapping
(Control-N)

Toggles snapping for both the canvas and timeline.
When snapping is on, the mouse snaps to various guide-lines. For
example, in the canvas, the mouse snaps your objects to the center and
edges of your canvas. It also snaps to other objects, if you have any. In
the timeline, the mouse snaps to the beginnings and endings of actions
and clips.
You can temporarily toggle snapping by holding down the Command key.
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Scrub Live Audio
(Shift-S)

When activated, you can hear the audio track while dragging the
scrubber.

Show Audio
Waveform

When activated, clips that contain audio have the audio waveform shown
along the center of the clip.

Show Thumbnail
Icons

When activated, each clip displays a thumbnail icon displaying either the
first frame of content (for video or image files) or a format icon for audio or
text clips.
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WINDOW MENU
This section describes each item in the Window menu.

Minimize
(Command-M)

Minimizes the foreground window.

Zoom

Scales the foreground window to the full size of the screen.

Markers

Opens a window listing the Markers (35) in the front-most document. You
can add, delete, rename, and jump to markers in this window.
Figure 69. Markers window

Bring All to Front

Brings all of ScreenFlow’s windows to the foreground.

Documents

Last in the menu is a list of all open document windows. These are listed
sequentially in the order they were opened.
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PURCHASE MENU
This menu is for purchasing and activating your ScreenFlow license.
Note: If your ScreenFlow license is already activated, this menu is not
available.

Purchase ScreenFlow
Online

Directs the user to the Licenses (71) pane of ScreenFlow Preferences to
purchase a license.

Unlock ScreenFlow

Directs the user to the Licenses (71) pane of ScreenFlow Preferences to
enter a license.
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HELP MENU
This section describes each item in the Help menu.

Search

Searches this documentation.

ScreenFlow Help
(Command-?)

Opens the main documentation window.

Visit ScreenFlow
Website

Opens the Web page for general ScreenFlow information.

Visit Support Page

Opens the Web page for ScreenFlow support information.

Provide ScreenFlow
Feedback

Opens the Web page for contacting technical support.
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APPENDIX C
Tr o u b l e s h o o t i n g
ScreenFlow
This section illustrates common questions with ScreenFlow which may be
addressed by the user. If your issue is not listed or the recommended
procedure does not work, please contact technical support.

Topics

Why doesn’t ScreenFlow play a movie file I imported? If ScreenFlow
can not play a movie file you’ve imported, attempt to open the media in
QuickTime Player. If QuickTime Player cannot open the file, most likely
the codec is not installed. If QuickTime Player can play the clip and the
clip does not play in ScreenFlow, please contact technical support.
I exported my video, but it looks fuzzy or blurry. What can I do to
make it look better? When using ScreenFlow, it can be difficult to record
your entire display at full resolution then compress that data into a lowresolution video while still retaining your necessary level of image clarity.
Here are a few things you can do:

• Export using the Lossless uncompressed video format. As long as you
do not lower the resolution, it is identical to the original recording, but
results in a large file size. This is ideal if you require additional editing
or reformatting outside of ScreenFlow before publishing it.

• Reduce your display resolution before recording (System Preferences/
Displays). By reducing your display resolution before recording, you
require less compression later. We recommend that you decide what
size you want your video to be in advance. Then, lower your display
resolution as close to that as possible, but no smaller. If you use a
smaller resolution than your output, you will lose image clarity.

• Use the scale and zoom functions in ScreenFlow. If you do not want to
reduce your display resolution or export to a large, uncompressed format, your best option is to use Video Properties > Scale or Callout
Action > Zoom. These functions allow you to increase the visibility on a
specific portion of the recording which can be valuable for maintaining
clarity in a heavily compressed video.

• Text is the hardest object to reproduce clearly in digital video. Digital
video was not designed to recreate detailed figures like text. It was
designed to map color spaces, so the thin lines of text can be particularly difficult to recreate. If you have text in your project, it is best to use
the Scale feature or to increase the text size before recording.
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How do you designate a recording area? Although many screen
capture programs function by designating a recording area, ScreenFlow
does not. ScreenFlow captures the entire screen and all of its contents.
This enables you to make use of the entire screen during the editing
process in post-production.
When using a program which designates a recording space, you may
unexpectedly move outside of this space due to a menu option or pop-up.
If your recording space is preset, there is no way to recover this lost
information. With ScreenFlow's reliance on post-production editing, you
can move outside your area of focus when necessary.
If you are recording a small video area and you are concerned that a full
screen recording will take up unnecessary disk space, ScreenFlow's
adaptive recording method captures minimal information on parts of the
screen where there is no action, so this has very little effect on file size.
Does ScreenFlow work with Parallels or VMware? Since ScreenFlow
captures everything on your monitor, both Parallels and VMware are
supported (including Computer Audio output). However, ScreenFlow
cannot use the Callout features as these are dependent upon unique
information provided by Mac OS X.
Telestream has run ScreenFlow with Parallels in all modes (Coherence,
Window, and Full Screen) without issue. In fact, using Parallels / VMware,
some users have reported ScreenFlow to produce smoother output while
using less CPU than native Windows screen capture applications.
What kind of graphics card should I use? ScreenFlow requires a
Quartz Extreme-capable graphics card. If you are unsure if your graphics
card is supported, please download our evaluation versions; ScreenFlow
will notify you if it is not supported. You can expect most Mac hardware
made in the last five years to fully support Quartz Extreme graphics cards.
ScreenFlow uses video RAM (or VRAM) during the recording process, so
it is important to have a graphics card with at least 64 MB of VRAM, but
we recommend 128 MB. The amount of VRAM necessary to record
smooth video depends on your display resolution and whether or not
other applications are simultaneously using VRAM. If you have
insufficient VRAM, the recording will drop frames and the video will
appear to be skipping.
Does ScreenFlow support audio interface or mixing devices?
ScreenFlow does not support audio interface or mixing devices. However
many of these devices will work with ScreenFlow if the audio is routed
properly. If you are having trouble with your mixer, we recommend posting
your issue on our forum.
Does ScreenFlow support closed captioning? ScreenFlow does not
support closed captioning. This process is performed following video
production in a separate application specifically designed for closed
captioning.
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How do I use ScreenFlow to record my iPod/iPhone/iPad?
ScreenFlow cannot record these devices directly, but can record
demonstrations using the XCODE simulator on Mac OS X.
My USB microphone and iSight camera are out of sync. What should
I do? If the audio and video are out of sync, try using the audio input on
the computer (not the USB input) as there can be a latency problem
between USB input and the iSight camera. This is particularly evident
when recording a "talking head." Use a microphone that utilizes the audio
input into the computer.
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Index

A

B

actions 37
curve type 92
Actions menu 92
activating your serial number 4
activation 71
changing license 72
deactivation 72
add chapter track from markers 54
adding a recording 23
annotations properties 46
color 46
endpoints 46
outline 46
shadow 46
shapes 46
thickness 46
arrows 46
audio
detach from video 85
ducking 40
effects 41
enable/disable waveform 94
audio driver 77
uninstalling 77
audio interface 100
audio properties 40
ducking 40
effect 41
mix input to mono 41
mute audio 40
smooth volume levels 41
volume 40
auto update 68
automated voice 89
axis rotation 39

background color 30
blur 44
brightness 39

C
callout properties 44
blur 44
blur background 44
border 44
build 45
feather 45
highlight 44
opacity 44
outline 45
round 45
shadow 45
zoom up 44
callouts 44
canvas 30
color 30
crop 30
snap to front window 30
zoom 93
canvas controls 30
censor 44
change license 72
changing speed 34
chapters 54
clip contact menu 35
clip inspector 35
closed captioning 100
common issues 99
compressing video 54
configure recording 20
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Index

contrast 39
copy 83
copyright notice ii
countdown 21, 68
create empty document 81
create or close gap 33
cropping
canvas 30
image 31
curve type 92
cut 83

D
deactivating license 72
delete media 49
detach audio 85
drawing shapes 46
ducking 40

E
Edit menu 83
add freeze frame 86
copy 83
cut 83
detach audio 85
lock/unlock clip 87
mark in point 87
mark out point 88
markers 88
paste 83
redo 83
ripple delete 87
special characters 88
split clip 85
trim to end 87
trim to front 87
undo 83
editing 27
actions 37
curve type 92
annotations properties 46
audio properties 40
blur 44
brightness 39
callout properties 44
canvas 30
canvas controls 30

editing (cont.)
changing speed 34
clip contact menu 35
clip inspector 35
contrast 39
create or close gap 33
drawing shapes 46
freeze frame 34, 86
group 34
highlight 44
image cropping 31
in and out points 33, 87
lock clip 34
markers 35, 88
media library 49
positioning 38
rename clip 35
ripple delete 87
saturation 39
scaling 31, 38
screen recording properties 42
split clip 33, 85
text boxes 47
text properties 47
timeline 32
tour 10
track selection 35
tracks 32
transitions 36
transitions inspector 36
trim 33
video properties 38
volume 40
window 28
editing window 28
canvas 30
timeline 32
tracks 32
election 35
export 52
chapters 54
customize 56
Flip4Mac (Windows Media) 58
QuickTime 56
dimensions 54
frame size 54
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export (cont.)
manage 53
Flip4Mac (Windows Media) 58
QuickTime 56
motion blur 54
presets
Apple TV 53
creating your own 53
customize 56
iPad 53
iPhone 53
iPod 53
Lossless 52
make settings default 53
Web - High 52
Web - Low 52
Windows Media 53
resolution 54
tour 16
video file size 54

F
FAQ 99
features
new 2
feedback 97
File menu 81
open 81
save 81
Flash 65
contents 66
how to publish 66
font 48
size 48
Font menu 90
copy style 91
kern 90
ligature 90
make text properties default 91
paste style 91
freeze frame 34, 86
full screen 93

G
group 34
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Help menu 97
ScreenFlow Help 97
search 97
visit ScreenFlow support 97
visit ScreenFlow website 97
Helper 22
hide desktop icons 22
highlight 44

I
image
cropping 31
opacity 39
reflection 39
scaling 31, 38
setting default duration 69
shadow 39
importing media 49
in and out points 33
clear 88
mark in 87
mark out 88
in points 33, 87
Insert menu 89
choose 89
media 89
speech clip 89
Text box 89
installing 75

K
kern 90

L
legal ii
licensing 71
change serial number 72
deactivation 72
upgrade 72, 76
ligature 90
lock clip 34
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Index

M
magnify 44
setting smoothness 70
manual 97
markers 35, 88
window 95
media library 49
add media 49
add recording 49
contact menu 49
delete 49
preview 49
rename 49
zoom 49
media management 49
menu 79
Actions 92
Edit 83
File 81
Font 90
Help 97
Insert 89
Purchase 96
ScreenFlow 80
View 93
Window 95
mix input to mono 41
motion blur 54
mute 40

N
narration 25
new features 2
normalize 41
notices ii

O
opacity 39
open 81
out points 33, 88

P
paste 83
paste properties 84

pointer
click effect 42
enlarge 42
image 42
opacity 42
sound 42
zoom 42
position 38
preferences 67
auto update 68
capture scratch disk 70
countdown 68
general 68
installing/uninstalling audio driver 70, 77
opening 80
preview 93
preview media 49
properties
actions 37
annotations 46
audio 40
callout 44
paste 84
screen recording 42
text 47
video 38
publish
Flash 65
Vimeo 62
YouTube 60
Purchase menu 96
purchasing 4, 96

Q
quit 80

R
recording
add 23
capturing text 25
compression 70
configure recording 20
countdown 21
pause hotkey 68
preferences 24
start/stop hotkey 68
tips 25
tour 8
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recovering lost recordings 70
redo 83
reflection 39
removing ScreenFlow 78
rename clip 35
rename media 49
repositioning 38
ripple delete 87
rotation 39

S
Safari, using to download installer 75
saturation 39
save 81
scaling 31
image 31, 38
setting smoothness 70
scratch disk 70
screen recording properties 42
click effect 42
opacity 42
pointer 42
pointer zoom 42
show keys pressed 43
show modifier keys pressed 43
sound on click 42
ScreenFlow
FAQ and Forum xv
tech support email xv
unlocking 4
website for xv
ScreenFlow Helper 22
disable 68
hide desktop icons 22
launch at user login 68
ScreenFlow menu 80
check for updates 80
provide ScreenFlow feedback 97
scrub live audio 94
serial number,entering 4
setting display resolution 25
shapes 46
show clip inspector 35
show keys pressed 43
show modifier keys 43
smooth volume levels 41
snapping 93
special characters 88
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speech clip 89
split clip 85
support xv, 97
system requirements 74

T
tech specs 74
technical specifications 74
technical support xv, 97
email address xv
website xv
Telestream
address xv
contacting vi, xv
information about xv
International xv
mailing address xv
sales and marketing xv
ScreenFlow email support site xv
ScreenFlow FAQ and Forum xv
ScreenFlow support site xv
technical support xv
Web site xv
Telestream Audio 77
uninstalling 77
text
kern 90
ligature 90
paste and match style 84
special characters 88
text boxes 47
backdrop 48
copy style 91
paste style 91
special characters 88
text properties 47
alignment 48
backdrop 48
fill 48
font 48
outline 48
paste and match style 84
set default 91
size 48
thumbnail icons 94
timeline 32
changing speed 34
clip contact menu 35
clip inspector 35
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timeline (cont.)
create or close gap 33
freeze frame 34, 86
group 34
in and out points 33, 87
lock clip 34
markers 35, 88
rename clip 35
scale 32
enable SMPTE timecode 69
split clip 33, 85
track selection 35
tracks 32
trim 33
track selection 35
tracks 32
setting default height 69
track controls 32
trademark notice ii
transitions 36
audio 36
overlapping 36
setting default 69
transitions inspector 36
transparency 39
trim 33
end 87
front 87
troubleshooting 99
audio interface 100
closed captioning 100
export video quality 99
graphics card 100
importing files 99
iPad 101
iPhone 101
iPod 101
out of sync 101
Parallels 100
recording area 100
VMWare 100

V

U

y rotation 39
YouTube 60
logging in 60
settings 60

undo 83
uninstalling ScreenFlow 78
unlocking ScreenFlow 4
update 80
automatic 68
upgrade license 76

version number, finding 80
video properties 38
brightness 39
contrast 39
opacity 39
position 38
reflection 39
saturation 39
scale 38
setting smoothness 70
shadow 39
x rotation 39
y rotation 39
z rotation 39
View menu 93
enter full screen 93
enter preview 93
scrub live audio 94
show audio waveform 94
show thumbnail icon 94
snapping 93
zoom 93
Vimeo 62
setting up your account 62
settings 64
verify account 64
volume 40

W
Warranty and Disclaimers v
website xv, 97
Window menu 95
markers 95

X
x rotation 39

Y

Z
z rotation 39
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